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Tableau Desktop Specialist 

Part 1: Connecting to and 

Preparing Data 

Create and save data connections 

• Create a live connection to a data source
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You can save a data source to either of the following formats: 
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Packaged Data Source (.tdsx) — contains all information in the data source (.tds) 

file, as well as a copy of any local file-based data or extracts. 

A packaged data source is a single zipped file. Use this format if you want to share 

your data source with people who do not have access to the underlying data that is 

defined in the connection information. 

Save a data source 

1. In Tableau Desktop, open the workbook that has the connection to the data you

want to save as a file.

2. At the top of the Data pane, right-click (Control-click on Mac) the name of the

data source, and then select Add to Saved Data Sources.

3. Enter a file name, select the file type (.tds or .tdsx), and then click Save.

By default, Tableau saves .tds and .tdsx files to the Datasources folder under your 

Tableau repository. When you use the default location, you can connect to the data 

source on the Connect pane. 

If you specified a different location, you can connect to the data source by 

selecting File > Open and navigating to it. 
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If you move a local data file that a .tds file contains a reference to, when you try to 

open the data source in Tableau, you will be prompted to locate or replace the original 

data source. If you replace the original data source, the replacement data must be of 

the same type (for example, Excel or MySQL). To avoid saving a specific file path, save 

the data source as a .tdsx file. 

A Tableau data source is the link between your data and Tableau. It is essentially the 

sum of your data, the connection information, and the customizations that you make 

on top of data to work with it in Tableau. The data source can contain: 

• Information about where the data is located, such as a file name and path or a

network location. Or, details on how to connect to your data, such as database

server name and server sign-in information.

• The names of any tables in the connection, as well as information about how the

tables relate to each other.

• A layer of customizations that you make on top of your data but that are not part

of the original data itself, such as calculations, groups, and renamed fields. For

details, see Organize and Customize Fields in the Data Pane.

After you connect to your data and select the first table to interact with from your 

database, a basic data source is created for you. 

• Explain the differences between using live connections versus

extracts

“Extract” is a word you’re going to hear a lot in Tableau. Extracts are one of the most 

powerful but overlooked tools in Tableau’s arsenal. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_dwfeatures.htm
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Tableau Data Extracts are snapshots of data optimized for aggregation and loaded 

into system memory to be quickly recalled for visualization. Extracts tend to be much 

faster than live connections, especially in more complex visualizations with large data 

sets, filters, calculations, etc. 

For a deep dive into how Tableau extracts are created, check out Gordon Rose’s 

fantastic blog post on the subject. 

When you create an extract from a local file (such as a .csv or an Excel workbook) or 

an on-premise database, you’re speeding up the workbook through optimization. As a 

result, Tableau doesn’t need the database to build the visualization. Instead, Tableau’s 

in-memory data engine queries the extract directly. 

However, because an extract is a snapshot of the data, the extract will need to be 

refreshed to receive updates from the original data source, whether it is a local file or 

an on-premise database. 

Live connections offer the convenience of real-time updates, with any changes in the 

data source reflected in Tableau. But live connections also rely on the database for all 

queries. And unlike extracts, databases are not always optimized for fast performance. 

With live connections, your data queries are only as fast as the database itself. 

There are also more variables at play when using a live connection. Workbook speeds 

are affected by a variety of factors, including your network speed, traffic on that 

network, and any custom SQL. 

• Create an extract

https://www.tableau.com/about/blog/2014/7/understanding-tableau-data-extracts-part1
https://www.tableau.com/about/blog/2014/7/understanding-tableau-data-extracts-part1
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Though there are a number of places in your Tableau work flow where you can create 

an extract, the primary method is described below. 

1. After you connect to your data and set up the data source on the Data Source

page, in the upper-right corner, select Extract, and then click the Edit link to

open the Extract Data dialog box.

2. (Optional) Configure one or more of the following options to tell Tableau how to

store, define filters for, and limit the amount of data in your extract: 

• Decide how the extract data should be stored

• You can choose to have Tableau store the data in your extract using one of two

structures (schemas): single table (denormamlized schema) or multiple tables

(normalized schema). The option you choose depends on what you need.

• Single table: Select Single table when you want to limit the amount of data in

your extract with additional extract properties like extract filters, aggregation,

etc.; or when your data uses pass-through functions (RAWSQL). This is the

default structure Tableau uses to store extract data. If you use this option when

your extract contains joins, the joins are applied when the extract is created.
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• Multiple tables: Select Multiple tables if your extract is comprised of tables

combined with one or more equality joins and meets the Conditions for using the

“Multiple tables” option listed below. If you use this option, joins are performed

at query time. 

• This option can potentially improve performance and help reduce the size of the

extract file. For more information about how Tableau recommends you use the

“Multiple tables” option, see Tips for using the “Multiple tables” option. In some

cases, you can also use this option as a workaround for row-level security. For

more information about row-level security using Tableau, see Restrict Access at

the Data Row Level.

• Conditions for using the “Multiple tables” option

• To store your extract using the “Multiple tables” option, the data in your extract

must meet all of the conditions listed below.

• All joins between tables are equality (=) joins

• Data types of the join columns are identical

• No pass-through functions (RAWSQL) used

• No incremental refresh configured

• No extract filters configured

• No top N or sampling configured

https://onlinehelp.tableau.com/current/pro/desktop/en-us/extracting_data.htm#normalized_conditions
https://onlinehelp.tableau.com/current/pro/desktop/en-us/extracting_data.htm#normalized_conditions
https://onlinehelp.tableau.com/current/pro/desktop/en-us/extracting_data.htm#noramlized_tips
https://onlinehelp.tableau.com/current/pro/desktop/en-us/publish_userfilters.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/publish_userfilters.htm
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• When the extract is stored as “Multiple tables,” you cannot append data to it.

• Note: Both the “Single table” and “Multiple tables” options only affect how the

data in your extract is stored. The options do not affect how tables in your extract

are displayed on the Data Source page.

• For example, suppose your extract is comprised of three tables. If you directly

open the extract (.hyper) file that has been configured to use the default option,

“Single table,” you see one table listed on the Data Source page. However, if you

open the extract using the packaged data source (.tdsx) file or the data source

(.tdsx) file with its corresponding extract (.hyper) file, you see all three tables that

comprise the extract on the Data Source page.

• Determine how much data to extract

• Click Add to define one or more filters to limit how much data gets extracted

based on fields and their values.
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• Aggregate the data in the extract

• Select Aggregate data for visible dimensions to aggregate the measures

using their default aggregation. Aggregating the data consolidates rows, can

minimize the size of the extract file, and increase performance.

• When you choose to aggregate the data, you can also select Roll up dates to a

specified date level such as Year, Month, etc. The examples below show how the

data will be extracted for each aggregation option you can choose.
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• Original data

• Each record is shown as a separate row. There are seven rows in your

data.Aggregate data for visible dimensions

• (no roll up)

• Records with the same date and region have been aggregated into a single row.

There are five rows in the extract.Aggregate data for visible dimensions

(roll up dates to Month)
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• Dates have been rolled up to the Month level and records with the same region

have been aggregated into a single row. There are three rows in the extract.

• Choose the rows to extract

• Select the number of rows you want to extract.

• You can extract All rows or the TopN rows. Tableau first applies any filters and

aggregation and then extracts the number of rows from the filtered and

aggregated results. The number of rows options depend on the type of data

source you are extracting from.

• Notes:

• Not all data sources support sampling. Therefore, you might not see

the Sampling option in the Extract Data dialog box.

• Any fields that you hide first in the Data Source page or on the sheet tab will be

excluded from the extract. Click the Hide All Unused Fields button to remove

these hidden fields from the extract

1. When finished, click OK.

2. Click the sheet tab. Clicking the sheet tab initiates the creating of the extract.

3. In the subsequent dialog box, select a location to save the extract, give the extract

file a name, and then click Save.

• Save metadata properties in a . TDS
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Data Source (.tds) — contains only the information you need to connect to the data 

source, including the following: 

• Data source type

• Connection information specified on the data source page; for example, database

server address, port, location of local files, tables

• Groups, sets, calculated fields, bins

• Default field properties; for example, number formats, aggregation, and sort

order

Use this format if everyone who will use the data source has access to the underlying 

file or database defined in the connection information. For example, the underlying 

data is a CSV file on your computer, and you are the only person who will use it; or the 

data is hosted on a cloud platform, and your colleagues all have the same access you 

do. 

Modify data connections 

If your data comes from multiple tables in different databases, you also can connect to 

your data and then combine the tables in Tableau. But before combining the tables, 

you must decide between setting up: 

• an individual data source for each connection to the database that contains the

tables that you need for your analysis, or

• a single data source with multiple independent connections to all the tables you

need for your analysis.
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When your data is stored in tables from different databases, you can choose from the 

following methods to combine data: 

• Data blending — supports one connection per data source, and one data source

per database (or Excel or text file)

• Cross-database join — allows two or more connections per data source

1. On the Data menu, select a data source, and then select Edit Data Source.

2. On the data source page, make the changes to the data source.

• Add a join

Overview of join types 
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In general, there are four types of joins that you can use to combine your data in 

Tableau: inner, left, right, and full outer. The tables you can join and the different join 

types you can use depend on the database or file you connect to. You can tell which 

join types your data supports by checking the join dialog after you’ve connected to 

your data and have at least two tables on the canvas. 

Inner 

When you use an inner join to combine tables, the result is a table that contains 

values that have matches in both tables. 

Left 

When you use a left join to combine tables, the result is a table that contains all values 

from the left table and corresponding matches from the right table. 

When a value in the left table doesn’t have a corresponding match in the right table, 

you see a null value in the data grid. 

Right 

When you use a right join to combine tables, the result is a table that contains all 

values from the right table and corresponding matches from the left table. 

When a value in the right table doesn’t have a corresponding match in the left table, 

you see a null value in the data grid. 
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Full outer 

When you use a full outer join to combine tables, the result is a table that contains all 

values from both tables. 

When a value from either table doesn’t have a match with the other table, you see a 

null value in the data grid. 

Union 

Though union is not a type of join, union is another method for combining two or 

more tables by appending rows of data from one table to another. Ideally, the tables 

that you union have the same number of fields, and those fields have matching names 

and data types. For more information about union, see Union Your Data. 

Combine tables from the same database 

If the tables you need to analyze are from the same database, or workbook (for Excel), 

or directory (for text) then use the following procedure to combine tables. Combining 

tables that are from the same database require only a single connection in the data 

source. Typically, joining tables from the same database yields better performance. 

This is because querying data that is stored on the same database takes less time and 

leverages the native capabilities of the database to perform the join. 

Note: Depending on the level of detail of the tables you want to combine, you might 

consider data blending instead. For more information, see Blend Your Data. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/union.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_connections.htm
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To join tables 

1. In Tableau Desktop: on the start page, under Connect, click a connector to

connect to your data. This step creates the first connection in the Tableau data

source.

2. In web authoring: Select New Workbook and connect to your data. This step

creates the first connection in the Tableau data source.

3. Select the file, database, or schema, and then double-click or drag a table to the

canvas.

1. Note: If you’re authoring on the web or signed in to Tableau Server (from

Tableau Desktop) while you are setting up the data source, you have access to

recommended tables to help make combining your data easier. For more

information, see Use Certified and Recommended Data Sources and Tables.

2. Double-click or drag another table to the canvas, and then click the join

relationship to add join clauses and select your join type.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/creator_connect.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datasource_recommended.htm
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1. Add one or more join clauses by selecting a field from one of the available tables

used in the data source, a join operator, and a field from the added table. Inspect

the join clause to make sure it reflects how you want to connect the tables.

2. For example, in a data source that has a table of order information and another

for returns information, you could use an inner join to combine the two tables

based on the Order ID field that exists in both tables.

1. Note: You can delete an unwanted join clauses by clicking the “x” that displays

when you hover over the right side of the join clause.

2. When you are finished, close the Join dialog.
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After you’ve created a join, review the data grid to make sure that the join produces 

the results that you expect. For more information, see Review join results in the data 

grid. To troubleshoot your join, see Troubleshoot joins. 

Continue to prepare your data source for analysis. You can rename and reset fields, 

create calculations, clean your data with Data Interpreter, change the data types of 

fields, and so on. 

Combine tables from different databases 

Beginning with Tableau version 10.0, if the tables you need to analyze are stored in 

different databases, or workbooks (for Excel), or directories (for text), use the 

following procedure to combine tables using a cross-database join. 

Cross-database joins require that you first set up a multi-connection data source — 

that is, you create a new connection to each database before you join tables. When you 

connect to multiple databases, a data source becomes a multi-connection data source. 

Multi-connection data sources can be advantageous when you need to analyze data 

for an organization that uses different internal systems or when you need to work 

with data that is managed separately by both internal and external groups. 

Note: In many cases, using a cross-database join is the primary method for 

combining your data. However, there are some cases that you might need to combine 

your data using data blending instead. For more information, see Blend Your Data. 

After you’ve combined tables using a cross-database join, Tableau colors the tables in 

the canvas and the columns in the data grid to show you which connection the data 

comes from. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/joining_tables.htm#results
https://onlinehelp.tableau.com/current/pro/desktop/en-us/joining_tables.htm#results
https://onlinehelp.tableau.com/current/pro/desktop/en-us/joining_tables.htm#troubleshoot
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_connections.htm
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To join tables from different databases 

1. In Tableau Desktop: On the Start page, under Connect, click a connector to

connect to your data. This step creates the first connection in the Tableau data

source.

2. In web authoring: Select New Workbook and connect to your data. This step

creates the first connection in the Tableau data source.

3. Select the file, database, or schema, and then double-click or drag a table to the

canvas.

1. In the left pane, under Connections, click the Add button (+ in web authoring)

to add a new connection to the Tableau data source. A new connection is required

if you have related data stored in another database.
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1. Note: If the connector you want is not available from the Connect list, cross-

database joins are not supported for the combination of sources that you want to

join. This includes connections to cube data (e.g., Microsoft Analysis Services),

most extract-only data (e.g., Google Analytics and OData), and Tableau Server

data sources. Instead of joining tables, consider using data blending. For more

information, see Blend Your Data.

2. Add one or more join clauses by selecting a field from one of the available tables

used in the data source, a join operator, and a field from the added table. Inspect

the join clause to make sure it reflects how you want to connect the tables.

3. For example, in a data source that has a table of order information and another

table of returns information, you could join the two tables based on the Order

ID field that exists in both tables. Select the type of join.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_connections.htm
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1. Note: You can delete an unwanted join clause by clicking the “x” that displays

when you hover over the right-side of the join clause.

2. When you are finished, close the Join dialog box.

3. Tables and columns are colored to show you which connection the data comes

from.

After you’ve created a cross-database join, continue to prepare your multi-connection 

data source for analysis. You can rename and reset fields, create calculations, clean 

your data with Data Interpreter, change the data types of fields, and so on. 

• Add a blend
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Use data blending instead of joins under the following conditions: 

• Data needs cleaning.

• If your tables do not match up with each other correctly after a join, set up data

sources for each table, make any necessary customizations (that is, rename

columns, change column data types, create groups, use calculations, etc.), and

then use data blending to combine the data.

• Joins cause duplicate data.

• Duplicate data after a join is a symptom of data at different levels of detail. If you

notice duplicate data, instead of creating a join, use data blending to blend on a

common dimension instead.

• You have lots of data.

• Typically joins are recommended for combining data from the same database.

Joins are handled by the database, which allows joins to leverage some of the

database’s native capabilities. However, if you’re working with large sets of data,

joins can put a strain on the database and significantly affect performance. In this

case, data blending might help. Because Tableau handles combining the data

after the data is aggregated, there is less data to combine. When there is less data

to combine, generally, performance improves.

Blend your data 

You can use data blending when you have data in separate data sources that you want 

to analyze together on a single sheet. The following example demonstrates how to 

blend data from two data sources: an Excel data source and an SQL Server data 

source. 
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Step 1: Connect to your data and set up the data sources 

1. Connect to a set of data and set up the data source on the data source page. This

example uses the Sample — Superstore data source.

2. Select Data > New data source, connect to the second set of data, and then set

up the data source. This example uses a SQL Server data source that contains

information about forecasted sales, called Sales Plan.

3. Click the sheet tab to start building your view.

Step 2: Designate a primary data source 

Drag at least one field from your primary data source into the view to designate it as 

the primary data source. 

1. In the Data pane, click the data source that you want to designate as the primary

data source. In this example, Sample — Superstore is selected.

2. Drag the fields you want to use from the data source into the view. In this

example, a view is created that shows Sales by Segment and Category.

Step 3: Designate a secondary data source 

Any fields used in the view from data sources that are not the primary data source or 

active links automatically designate subsequent data sources as the secondary data 

source. 

1. In the Data pane, click the data source that you want to designate as the

secondary data source. In this example, the Sales Plan data source is selected.
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2. When you complete this step, an orange bar displays down the left side of the

Data pane. The orange bar indicates the secondary data source. In addition to the

orange bar, broken link icons display next to potential linking fields.

3. Click a broken link icon ( 
 

1. ) to establish a relationship between the secondary and primary data sources. 

This is the field that determines the level of detail that Tableau should aggregate 

to. In this example, Segment is the linking field. 

2. If a broken link icon does not appear next to the field that should be the linking

field or no broken links appear, see Step 4: (Optional) Define or edit

relationships .

3. Drag the fields you want to use from the secondary data source into the view. In

this example, Sales Plan field is used on the Detail card to change the level of

detail of the view.

Step 4: (Optional) Define or edit relationships 

Tableau detects when a field from the primary data source also exists in a secondary 

data source, and indicates that the fields are potential linking fields by marking them 

with a broken link icon in the Data pane. You click a broken link icon to establish a 

relationship between the primary and secondary data sources, and have Tableau 

blend data from both data sources on a single sheet. 

You must have at least one linked field in order to use data from the secondary data 

source. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_connections.htm#step4relationships
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_connections.htm#step4relationships
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1. Select Data > Edit Relationships.

2. In the Relationships dialog box, verify that the primary data source is selected

from the Primary data source drop-down list. In this example, the Sample —

Superstore data source is selected.

3. Select the secondary data source in the Secondary data source pane,

select Custom in the relationships list, and then click the Add button. In this

example, the Sales Plan data source is selected.

4. In the Add/Edit Field Mapping dialog box, do the following:

5. Select a field from the primary data source.

6. Select a field from the secondary data source to establish the linking field or the

relationship between the data sources even though the fields do not have the

same name.

7. Click OK.

8. In this example, a relationship between Segment field in the Superstore —

Sample data source is selected and Customer Segment field in the Sales Plan

data source is selected. You can map these two fields to create a relationship even

though they don’t have the same name.

9. (Optional) Continue to add and remove as many relationships as necessary and

then click OK.

10. The related fields are shown in the secondary data source as potential linking

fields.

11. Click the broken link icon ( 
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1. ) next to these fields in the data pane to make the relationship between the

primary and secondary data sources active. In this case, the broken link icon next

to Customer Segment is made into an active link icon ( 
 

1. ). 

2. If the related field from the primary data source is used in the view, the link

becomes active automatically.

When data blending, the relationship matches values based on the member aliases. 

You can fix fields that don’t match by editing the aliases. For example, when you map 

a Segment field in the primary data source to the Segment field in the secondary 

data source, “Small Business” will not map correctly to “S. Business”. You must edit 

the aliases in one of the data sources. For more information, see Create Aliases to 

Rename Members in the View. 

You can also use a secondary data source to re-alias the field values in a primary data 

source. For more information, see Alias Field Values Using Data Blending. 

• Add a union

Unioning is a method for appending values (that is, rows) to tables. You can union 

tables if they have the same columns. The result of combining data using a union is a 

virtual table that has the same columns but extends vertically by adding rows of data. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_fieldproperties_aliases_ex1editing.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_fieldproperties_aliases_ex1editing.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multipleconnections_edit_primary_aliases.htm
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You can union your data to combine two or more tables by appending values (rows) 

from one table to another. To union your data in Tableau data source, the tables must 

come from the same connection. 

Supported connectors 

If your data source supports union, the New Union option displays in the left pane 

of the data source page after you connect to your data. You can also refer to the 

following lists to verify that your data source supports union: 

Tableau Desktop 

• Excel

• Text File

• Google Sheets

• JSON File

• PDF File

• Amazon Redshift

• Aster Database
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• Cloudera Hadoop

• Google BigQuery

• Hortonworks Hadoop

• Vertica

• IBM DB2

• IBM PDA (Netezza)

• Microsoft SQL

• MySQL

• Oracle

• PostgreSQL

• Pivotal Greenplum Database

• SAP Sybase ASE

• SAP Sybase IQ

• Teradata

Web authoring (Tableau Online and Tableau Server) 

• Excel

• Text File

• Amazon Aurora
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• Amazon Redshift

• Google Cloud SQL

• IBM BigInsights

• IBM DB2

• IBM PDA (Netezza)

• MemSQL

• Microsoft SQL

• MySQL

• Pivotal Greenplum Database

• PostgreSQL

• SAP Sybase ASE

• SAP Sybase IQ

• Vertica

For best results, the tables that you combine using a union must have the same 

structure. That is, each table must have the same number of fields, and related fields 

must have matching field names and data types. 

For example, suppose you have the following customer purchase information stored 

in three tables, separated by month. The table names are “May2016,” “June2016,” 

and “July2016.” 
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Union tables manually 

Use this method to manually union distinct tables. This method allows you to drag 

individual tables from the left pane of the Data Source page and into the Union dialog 

box. 

To union tables manually 

1. On the data source page, double-click New Union to set up the union.

1. Drag a table from the left pane to the Union dialog box.

1. Select another table from the left pane and drag it directly below the first table.
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1. Tip: To add multiple tables to a union at the same time,

press Shift or Ctrl(Shift or Command on a Mac), select the tables you want to

union in the left pane, and then drag them directly below the first table.

2. Click Apply or OK to union.

Union tables using wildcard search (Tableau 

Desktop) 

Use this method to set up search criteria to automatically include tables in your union. 

Use the wildcard character, which is an asterisk (*), to match a sequence or pattern of 

characters in the Excel workbook and worksheet names, Google Sheets workbook and 

worksheet names, text file names, JSON file names, .pdf file names, and database 

table names. 

When working with Excel, text file data, JSON file, .pdf file data, you can also use this 

method to union files across folders, and worksheets across workbooks. Search is 

scoped to the selected connection. The connection and the tables available in a 

connection are shown on the left pane of the Data source page. 

To union tables using wildcard search 
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1. On the data source page, double-click New Union to set up the union.

1. Click Wildcard (automatic) in the Union dialog box.

1. Enter the search criteria that you want Tableau to use to find tables to include in

the union.

1. For example, you can enter *2016 in the Include text box to union tables in

Excel worksheets that end with “2016” in their names. Search criteria like this will

result in the union of May2016, June2016, and July2016 tables (Excel

worksheets), from the selected connection. In this case, the connection is called
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Sales, and the connection made to the Excel workbook containing the worksheets 

you wanted was in the quarter_3 folder in the sales directory (e.g., 

Z:\sales\quarter_3). 

2. Click Apply or OK to union.

Manage data properties 

• Rename a data field

Rename column: Double-click the name of the column to rename the field. 

Reset name: If you’ve renamed a field, click the column drop-down menu, and then 

select Reset Name to revert back to the original name of the field. You can also 

select multiple columns and perform the same action. 
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Original name indicates the name specified in the underlying data. You can use 

the Revert command to reset field names that have changed as a result of naming 

improvements Tableau has automatically made to the data source. For more 

information, see 

• Assign an alias to a data value

You can create aliases (alternate names) for members in a dimension so that their 

labels appear differently in the view. 

Aliases can be created for the members of discrete dimensions only. They cannot be 

created for continuous dimensions, dates, or measures. 

Note: When using a published data source, you cannot create or edit aliases. 

To create an alias: 

1. In the Data pane, right-click a dimension and select Aliases.
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1. In the Edit Aliases dialog box, under Value (Alias), select a member and enter a

new name.
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1. Tip: To reset the member names back to their original names, click Clear

Aliases.

2. To submit your changes:

• In Tableau Desktop, click OK.

• On Tableau Server or Tableau Online, click the X icon in the top-right corner of

the dialog box.

• Change data type for a data field (number, date, string, boolean, etc.)
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All fields in a data source have a data type. The data type reflects the kind of 

information stored in that field, for example integers (410), dates (1/23/2015) and 

strings (“Wisconsin”). The data type of a field is identified in the Data pane by one of 

the icons shown below. 

Data type icons in Tableau 

IconData type 

Text (string) values 

Date values 

Date & Time values 

Numerical values 

Boolean values (relational only) 

Geographic values (used with maps) 

Cluster Group (used with Find Clusters in Data) 

You can change the data type for a field either on the Data Source page or in 

the Datapane. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/clustering.htm
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Change the data type for a field in the Data 

Source page 

Sometimes Tableau incorrectly interprets the data type of a field. For example, 

Tableau might interpret a field that contains dates as an integer data type, rather than 

a date data type. 

You can change the data type for a field that was part of the original data source (as 

opposed to a calculated field created in Tableau) on the Data Source page. 

1. Click the data type icon for the field (as shown in the table above).

2. Choose a new data type from the drop-down list:

Tip: Be sure to change data types before you create an extract. Otherwise, your data 

may not be accurate. For example, if a floating-point field in the original data source 

is interpreted as an integer by Tableau, and you create your extract before you change 

the field’s data type, the resulting floating-point field in Tableau will have some of its 

precision truncated. 

For information on changing data types on the Data Source page, see Data Source 

Page. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/environment_datasource_page.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/environment_datasource_page.htm


 pg. 39 

ITS427 Tableau Certification 

Change the data type for a field in the Data pane 

To change the data type of a field in the Data pane, click the icon to the left of the 

field name, and then choose a new data type from the drop-down list. 

Change the data type for a field in the view 

To change a field’s data type in a view, right-click (control-click on a Mac) the field in 

the Data pane, choose Change Data Type, and then select the appropriate data 

type from the drop-down list. 
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Note: Sometimes the data in your database is more precise then Tableau can model. 

When you add these values to the view, a precision warning appears in the right 

corner of the status bar. See Status Bar Information 

• Change default properties for a data field (number format,

aggregation, color, date format, etc.)

When you drag fields to shelves, the data is represented as marks in the view. The 

fields and their marks are displayed initially based on their default settings. You can 

control these default settings by clicking the drop-down arrow on a field. 

The Default Properties menu includes default settings for aggregation, comments, 

number formatting, color, shape, and totals (based on the type of field). 

Set the default aggregation for a measure 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/environment_workspace.htm#StatusBar
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You can specify a default aggregation for any measure. The default aggregation will be 

used automatically when the measure is first totaled in the view. 

1. Right-click (control-click on a Mac) any measure in the Data pane and

select Default Properties > Aggregation.

2. On the Aggregation list, select an aggregation.

1. Whether you are specifying the aggregation for a field on a shelf or the default

aggregation in the Data pane, you can select from several aggregations. See Data

Aggregation in Tableau to learn about each type of aggregation.

Add default comments for specific fields 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm
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Fields can have comments that describe them. The comments display in a tooltip in 

the Data pane and in the Calculated fields dialog box. Field comments are a good way 

to give more context to the data in your data source. Comments are especially useful 

when you are building a workbook for others to use. 

To add a default comment for a field 

1. Right-click (control-click on a Mac) a field in the Data pane and select Default

Properties > Comment.

2. Write a comment in the subsequent dialog box. Comments support rich text

formatting that will be represented in the tooltip.

1. When finished, click OK.

2. Now when you hover the cursor over the field in the Data pane, you see the

comment.
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Set the default number format 

You can set the default number format for date and number fields. For example, you 

may want to always show the Sales values as currency using the U.S. dollar sign and 

two decimal places. Or you may want to always show Discount as a percentage. 

To set the default formats, right-click (control-click on Mac) a date or number field 

and select either Date Format or Number Format on the Default Properties 

menu. A dialog box opens where you can specify a default format. 

Set the default color 
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When you use a dimension to color encode the view, default colors are assigned to the 

field’s values. Color encodings are shared across multiple worksheets that use the 

same data source to help you create consistent displays of your data. For example, if 

you define the Western region to be green, it will automatically be green in all other 

views in the workbook. To set the default color encodings for a field, right-click 

(control-click on Mac) the field in the Data pane and select Default 

Properties > Color. 

For information about color properties, and how to configure and customize colors in 

Tableau, see Color Palettes and Effects, 

Set the default shape 

When you use a dimension to shape encode the view, default shapes are assigned to 

the field’s values. Shape encodings are shared across multiple worksheets that use the 

same data source to help you create consistent displays of your data. For example, if 

you define that Furniture products are represented with a square mark, it will 

automatically be changed to a square mark in all other views in the workbook. 

To set the default shape encodings for a field, right-click (control-click on Mac) the 

field in the Data pane and select Default Properties > Shape. 

Set the default sort order for the values within a 

categorical field 

You can set a default sort order for the values within a categorical field so that every 

time you use the field in the view, the values will be sorted correctly. For example, let’s 

say you have an Order Priority field that contains the values High, Medium, and Low. 

When you place these in the view, by default they will be listed as High, Low, Medium 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/viewparts_marks_markproperties_color.htm
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because they are shown in alphabetical order. You can set a default sort so that these 

values are always listed correctly. 

To set the default sort order, right-click (control-click on a Mac) a dimension and 

select Default Properties > Sort. Then use the sort dialog box to specify a sort 

order. 

Part 2: Exploring and 

Analysing Data 

• Create a bar chart

Use bar charts to compare data across categories. You create a bar chart by placing a 

dimension on the Rows shelf and a measure on the Columns shelf, or vice versa. 

A bar chart uses the Bar mark type. Tableau selects this mark type when the data 

view matches one of the two field arrangements shown below. You can add additional 

fields to these shelves. 

For more information about the Bar mark type, see Bar mark. 

Note: At the end of the procedure is an extra step you can take to display totals at the 

tops of the bars. 

Creates Vertical Bars 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/viewparts_marks_marktypes.htm#BarMark
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Creates Horizontal Bars 

To create a bar chart that displays total sales over a four-year period, follow these 

steps: 

1. Connect to the Sample — Superstore data source.

2. Drag the Order Date dimension to Columns.

3. The data is aggregated by year and column headers appear.

4. Drag the Sales measure to Rows.

5. The measure is aggregated as a sum and an axis is created. The column headers

move to the bottom of the view.

6. Tableau uses Line as the mark type because you added the date dimension.
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1. On the Marks card, select Bar from the drop-down list.

1. The view changes to a bar chart.
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1. The marks (which are bars in this case) are vertical because the axis is vertical.

The length of each mark represents the sum of the sales for that year. The actual

numbers you see here might not match the numbers you see — the sample data

changes from time to time.

1. Drag the Ship Mode dimension to Color on the Marks card.



 pg. 49 

ITS427 Tableau Certification 

2. The view shows how different shipping modes have contributed to total sales over

time. The ratios look consistent from year to year.

1. Drag the Region dimension to Rows, and drop it to the left of Sales to produce

multiple axes for sales by region.
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1. To view data in the West region only, you can filter out the other regions. To do

this, drag the Region dimension again, this time from the Data pane to

the Filters shelf.
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1. In the Filter [Region] dialog box, clear the Central, East, and South check

boxes, and then click OK.

• Create a line chart

To create a view that displays the sum of sales and the sum of profit for all years, and 

then uses forecasting to determine a trend, follow these steps: 

1. Connect to the Sample — Superstore data source.

2. Drag the Order Date dimension to Columns.

3. Tableau aggregates the date by year, and creates column headers.

4. Drag the Sales measure to Rows.

5. Tableau aggregates Sales as SUM and displays a simple line chart.

6. Drag the Profit measure to Rows and drop it to the right of the Sales measure.

7. Tableau creates separate axes along the left margin for Sales and Profit.
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1. Notice that the scale of the two axes is different — the Sales axis scales from $0

to $700,000, whereas the Profit axis scales from $0 to $100,000. This can make

it hard to see that sales values are much greater than profit values.
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2. When you are displaying multiple measures in a line chart, you can align or

merge axes to make it easier for users to compare values.

3. For more information about aligning the axes, see Compare two measures using

dual axes.

4. For more information about enforcing a single axis across multiple measures,

see Blend axes for multiple measures into a single axis.

5. With either of these options, you can create a combination chart to change the

mark type for one of your measures.

6. For more information, see Create a combo chart (assign different mark types to

measures).

7. Drag the SUM(Profit) field from Rows to the Sales axis to create a blended

axis. The two pale green parallel bars indicate that Profit and Sales will use a

blended axis when you release the mouse button.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_measures.htm#Dual
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_measures.htm#Dual
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_measures.htm#Blended
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_measures.htm#Combo
https://onlinehelp.tableau.com/current/pro/desktop/en-us/multiple_measures.htm#Combo
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1. The view updates to look like this:
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1. The view is rather sparse because we are looking at a summation of values on a

per-year basis.

2. Click the drop-down arrow in the Year(Order Date) field on

the Columns shelf and select Month in the lower part of the context menu to

see a continuous range of values over the four-year period.
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1. The resulting view is a lot more detailed than the original view:
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1. Notice that the values seem to go much higher just before the end of each year. A

pattern like that is known as seasonality. If we turn on the forecasting feature in

the view, we can see whether we should expect that the apparent seasonal trend

will continue in the future.

2. To add a forecast, in the Analytics pane, drag the Forecast model to the view,

and then drop it on Forecast.
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1. We then see that, according to Tableau forecasting, the seasonal trend does

continue into the future:
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• Create a scatterplot

Use scatter plots to visualize relationships between numerical variables. 

In Tableau, you create a scatter plot by placing at least one measure on 

the Columns shelf and at least one measure on the Rows shelf. If these shelves 

contain both dimensions and measures, Tableau places the measures as the 

innermost fields, which means that measures are always to the right of any 

dimensions that you have also placed on these shelves. The word “innermost” in this 

case refers to the table structure. 

Creates Simple Scatter Plot 

Creates Matrix of Scatter Plots 

To use scatter plots and trend lines to compare sales to profit, follow these steps: 

1. Open the Sample — Superstore data source.

2. Drag the Profit measure to Columns.

3. Tableau aggregates the measure as a sum and creates a horizontal axis.

4. Drag the Sales measure to Rows.

5. Tableau aggregates the measure as a sum and creates a vertical axis.
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6. Measures contain continuous numerical data. When you plot one number against

another, you are comparing two numbers; the resulting chart is analogous to a

Cartesian chart, with x and y coordinates.

7. Now you have a one-mark scatter plot:

1. Drag the Category dimension to Color on the Marks card.

2. This separates the data into three marks — one for each dimension member —

and encodes the marks using color.
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1. Drag the Region dimension to Detail on the Marks card.

2. Now there are many more marks in the view. The number of marks is equal to the

number of distinct regions in the data source multiplied by the number of

departments. (If you’re curious, use the Undo button on the toolbar to see what

would have happened if you’d dropped the Region dimension on Shape instead

of Detail.)
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1. To add trend lines, from the Analytics pane, drag the Trend Line model to the

view, and then drop it on the model type.

1. A trend line can provide a statistical definition of the relationship between two

numerical values. To add trend lines to a view, both axes must contain a field that
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can be interpreted as a number — by definition, that is always the case with a 

scatter plot. 

2. Tableau adds three linear trend lines — one for each color that you are using to

distinguish the three categories.

1. Hover the cursor over the trend lines to see statistical information about the

model that was used to create the line:
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1. For more information, see Assess Trend Line Significance. You can also

customize the trend line to use a different model type or to include confidence

bands. For more information, see Add Trend Lines to a Visualization.

• Create a map using geographic data

You can build several different types of maps for your geographic analysis in Tableau. 

If you’re new to maps, or simply want to take advantage of the built in mapping 

capabilities that Tableau provides, you can create a simple point or filled (polygon) 

map similar to the examples below. 

Prerequisites: To build a simple map, your data source must contain location data 

(location names, or latitude and longitude coordinates). If your data source does not 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/trendlines_add.htm#significance
https://onlinehelp.tableau.com/current/pro/desktop/en-us/trendlines_add.htm
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contain location data, see the Map Data section for ways you can connect to location 

data. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/maps_data.htm
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This topic illustrates how to create a simple map using an example. To follow along 

with the example below, open Tableau Desktop and connect to the Sample-

Superstore data source, which comes with Tableau. 

Build a simple point map 

1. Navigate to a worksheet.

2. In the Data pane, under Dimensions, double-click State.

3. A map view is automatically created because the State field is a geographic field.

To learn more about geographic fields and how to create them, see Assign a

geographic role to a field.

1. From Measures, drag Sales to Size on the Marks card.

2. The data points on the map update to show the amount of sales proportionally.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/maps_geographicroles.htm#AssignRole
https://onlinehelp.tableau.com/current/pro/desktop/en-us/maps_geographicroles.htm#AssignRole
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1. Select Maps > Map Layers.

2. In the Map Layers pane, do the following:

• Click the Style drop-down and select Normal.

• Under Map Layers, clear Country/Region Names.

1. The background map updates with the new settings.
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Build a simple filled (polygon) map 

1. Navigate to a new worksheet.

2. In the Data pane, under Dimensions, double-click State.

3. A map view is automatically created.



 pg. 70 

ITS427 Tableau Certification 

1. On the Marks card, click the Mark Type drop-down and select Map.

1. The map view updates to a filled (polygon) map.
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1. From Dimensions, drag Sales to Color on the Marks card.

2. The polygons on the map update to show the amount of sales using color.
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• Create a combined axis chart

Combination charts are views that use multiple mark types in the same visualization. 

For example, you may show sum of profit as bars with a line across the bars showing 

sum of sales. You can also use combination charts to show multiple levels of detail in 

the same view. For example, you can have a line chart with individual lines showing 

average sales over time for each customer segment, then you can have another line 

that shows the combined average across all customer segments. 

To create a combination chart, follow the steps below: 

1. Open Tableau Desktop and connect to the Sample — Superstore data source.

2. Navigate to a new worksheet.
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3. From the Data pane, under Dimensions, drag Order Date to

the Columns shelf.

4. On the Columns shelf, right-click YEAR(Order Date) and select Month.

1. From the Data pane, under Measures, drag Sales to the Rows shelf.

2. From the Data pane, under Measures, drag Profit to the Rows shelf and place it

to the right of SUM(Sales).

3. On the Rows shelf, right-click SUM(Profit) and select Dual-Axis.
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1. The view updates to look like the following. Measure Names is added to Color on

the Marks card to differentiate the lines.
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1. Note: Some marks can be hidden behind others. To move the marks forward or

backward, right-click one of the axes in the visualization and select Move Marks

to Back or Move Marks to Front.

2. On the SUM(Profit) Marks card, click the Mark Type drop-down and select Bar.

1. In the visualization, right-click the Profit axis and select Synchronize Axis.
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1. The visualization updates to look like the following.
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• Create a dual axis chart

Option 1 

1. Move two Measures (not Dimensions) to the Rows shelf.

2. Right-click the second measure on the Rows shelf, and select Dual Axis.

3. On the Marks card labeled All, set the mark type to Bar.

4. Use the slider on the Marks card for each measure to adjust the size of each bar,

so that the one layered on top is narrower than the one on the bottom.

5. Right-click the right-side axis and select Synchronize Axis.

6. Optionally, right-click the right-side axis and select Show Header to toggle off

the labels on the right side.

7. Switch one measure from one side to the other in the Rows shelf to move one

measure foward.

Option 2 

1. Drag Order Date to Columns

2. Drag Sales and Profit to Rows.

3. Click the top right corner arrow on Profit and select Dual Axis.

• Alternatively, you can right click on Profit and select Dual Axis in the view

directly.

1. Right click on the Profit Axis and select Synchronize axis
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2. Change the mark type as desired

Option 3 

1. Drag Order Date to Columns

2. Drag Sales to Rows.

3. Drag and drop other Measures to the Value axis

• Create a stacked bar

Option 1: Use a separate bar for each dimension 

1. Drag a dimension to Columns.

2. Drag Measure Names to Color on the Marks card.

3. On Color, right-click Measure Names, select Filter, select the check boxes for

the measures to display, and then click OK.

4. From the Measures pane, drag Measure Values to Rows.

5. On the Marks card, change the mark type from Automatic to Bar. For more

information, see Bar Mark.

Option 2: Use a separate bar for each measure 

1. Drag a dimension to the Color shelf.

2. Drag Measure Names to Columns.

3. On the Columns shelf, right-click Measure Names, select Filter, select the

check boxes for the measures to display, and then click OK.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/help.htm#viewparts_marks_marktypes_bar.html
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4. From the Measures pane, drag Measure Values to Rows.

• Create a chart to show specific values (crosstab, highlight table)

Use highlight tables to compare categorical data using color. 

In Tableau, you create a highlight table by placing one or more dimensions on 

the Columns shelf and one or more dimensions on the Rows shelf. You then 

select Square as the mark type and place a measure of interest on the Color shelf. 

You can enhance this basic highlight table by setting the size and shape of the table 

cells. 

To create a highlight table to explore how profit varies across regions, product sub-

categories, and customer segments, follow these steps: 

1. Connect to the Sample — Superstore data source.

2. Drag the Segment dimension to Columns.

3. Tableau creates headers with labels derived from the dimension member names.

4. Drag the Region and Sub-Category dimensions to Rows, dropping Sub-

Category to the right of Region.

5. Now you have a nested table of categorical data (that is, the Sub-

Categorydimension is nested within the Region dimension).

6. Drag the Profit measure to Color on the Marks card.
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7. Tableau aggregates the measure as a sum. The color legend reflects the

continuous data range.

1. In this view, you can see data for only the Central region. Scroll down to see data

for other regions.

2. In the Central region, copiers are shown to be the most profitable sub-category,

and binders and appliances the least profitable.

3. Click Color on the Marks card to display configuration options. In

the Border drop-down list, select a medium gray color for cell borders, as in the

following image:
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1. Now it’s easier to see the individual cells in the view:
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1. The default color palette is Orange-Blue Diverging. A Red-Green Diverging

palette might be more appropriate for profit. To change the color palette and to

make the colors more distinct, do the following:

• Hover over the SUM(Profit) color legend, then click the drop-down arrow that

appears and select Edit Colors.

• In the Edit Colors dialog box, in the Palette field, select Red-Green

Divergingfrom the drop-down list.

• Select the Use Full Color Range check box and click Apply and then click OK.
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• When you select this option, Tableau assigns the starting number a full intensity

and the ending number a full intensity. If the range is from -10 to 100, the color

representing negative numbers changes in shade much more quickly than the

color representing positive numbers.

• When you do not select Use Full Color Range, Tableau assigns the color

intensity as if the range was from -100 to 100, so that the change in shade is the

same on both sides of zero. The effect is to make the color contrasts in your view

much more distinct.

• For more information about color options, see Color Palettes and Effects.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/viewparts_marks_markproperties_color.htm
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1. Drag the Sales measure to Size on the Marks card to control the size of the

boxes by the Sales measure. You can compare absolute sales numbers (by size of

the boxes) and profit (by color).

2. Initially, the marks look like this:
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1. To enlarge the marks, click Size on the Marks card to display a size slider:

1. Drag the slider to the right until the boxes in the view are the optimal size. Now

your view is complete:
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Check your work! Watch steps 1–9 below: 
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• Create a chart to show specific values

Organize data and apply filters 

You can create filters on a data source, thereby reducing the amount of data in the 

data source. 

If you create an extract from a data source that already has data source filters in place, 

those filters are automatically recommended as extract filters, and will appear in the 

Extract dialog. Those recommended filters are not required to be part of the Extract 

filter list, and can safely be removed without affecting the existing set of data source 

filters. 
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Data source filters can be useful for restricting the data users can see when you 

publish a workbook or data source. When you publish a data source to Tableau 

Server, the data source and any associated files or extracts are transported in entirety 

to the Server. As you publish a data source you can define access permissions for 

downloading or modifying the data source, and you can also choose the users and 

groups who can remotely issue queries through Tableau Server against that data 

source. When users have query permission and no download permission, you can 

share a rich data model having calculated fields, aliases, groups, sets and more — but 

only for querying. 

Furthermore, users who query published data source will never be able to see or 

modify any data source filters present on the originally published data source, but all 

of the users’ queries will be subject to those data source filters. This is a great way to 

offer a restricted subset of your data, for example by filtering dimensions for specific 

users and groups, or by defining data source filters based on a fixed or relative date 

range. This is often useful for data security, and it also allows you to manage 

performance of the remote database which Tableau Server will ultimately query on a 

user’s behalf. For systems that rely heavily on partitions or indexing, data source 

filters may yield tremendous control over the performance of queries issued by 

Tableau. 

Create a data source filter 

The primary way to create a data source filter is from the data source page. 

To create a data source filter 

1. On the data source page, click Add in the Filters section in the upper-right corner

of the page.
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2. Click Add to open an Add Filter dialog box listing all fields in the data source.

3. Click to select a field to filter; then specify how the field should be filtered, just as

you would for a field on the Filters shelf.

4. To add an additional data source filter, repeat this procedure.

Global filters and data source filters 

When you create a data source filter, any global filters that use that data source are 

displayed automatically in the Edit Data Source Filters dialog box to make it easy 

for you to promote a global filter to be a data source filter. To promote the global filter 

to be a data source filter, click OK. 

If you promote a global filter to be a data source filter, that global filter will no longer 

be visible in worksheets of the workbook (because it becomes a data source filter). 

Important: Be aware that you do not need to select a global filter in the Edit Data 

Source Filters dialog box to promote it. When you click OK, all global filters in the 

list will be promoted. 

To prevent a global filter from being promoted to a data source filter, select the global 

filter in the Edit Data Source Filters dialog box, and then click Remove. 
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• Create a visual group

You can create a group to combine related members in a field. For example, if you are 

working with a view that shows average test scores by major, you might want to group 

certain majors together to create major categories. English and History might be 

combined into a group called Liberal Arts Majors, while Biology and Physics might be 

grouped as Science Majors. 

Groups are useful for both correcting data errors (e.g., combining CA, Calif., and 

California into one data point) as well as answering “what if” type questions (e.g., 

“What if we combined the East and West regions?). 

Create a group 

There are multiple ways to create a group. You can create a group from a field in 

the Data pane, or by selecting data in the view and then clicking the group icon. 

Create a group by selecting data in the view 

1. In the view, select one or more data points and then, on the tooltip that appears,

click the group icon .
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2. Note: You can also select the group icon on the toolbar at the top of the

workspace.

3. If there are multiple levels of detail in the view, you must select a level to group

the members. You can select to group all dimensions, or just one.

Create a group from a field in the Data pane 

1. In the Data pane, right-click a field and select Create > Group.

2. In the Create Group dialog box, select several members that you want to group,

and then click Group.

The selected members are combined into a single group. A default name is created 

using the combined member names. 

To rename the group, select it in the list and click Rename. 

Tip: You can search for members using the Find option near the bottom-right of the 

dialog box. (Tableau Desktop only) 

Include an Other Group 

When you create groups in Tableau, you have the option to group all remaining, or 

non-grouped members in an Other group. 

The Include Other option is useful for highlighting certain groups or comparing 

specific groups against everything else. For example, if have a view that shows sales 

versus profit product category, you might want to highlight the high and low 
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performing categories in the view, and group all the other categories into an “Other” 

group. 

Includes OtherDoes not include Other 

To include an Other group: 

1. In the Data pane, right-click the group field and select Edit Group.

2. In the Edit Group dialog box, select Include ‘Other’.

Edit a Group 

After you have created a grouped field, you can add and remove members from the 

groups, create new groups, change the default group names, and change the name of 

the grouped field. You can make some changes directly in the view, and others 

through the Edit Group dialog box. 

To add members to an existing group: 

• In the Data pane, right-click the group field, and then click Edit Group.

• In the Edit Group dialog box, select one or more members and drag them into the

group you want.

• Clik OK.

To remove members from an existing group: 

• In the Data pane, right-click the group field, and then click Edit Group.
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• In the Edit Group dialog box, select one or more members, and then

click Ungroup.

• The members are removed from the current group. If you have an Other group,

the members are added to it.

• Click OK.

To create a new group in a group field: 

• In the Data pane, right-click the group field, and then click Edit Group.

• In the Edit Group dialog box, select one or more members, and then click Group.

• Click OK.

Note: To rename a group, select the group in the Edit Group dialog box, and then 

click Rename. 

• Create a group using labels

• Create a set

Create a dynamic set 

The members of a dynamic set change when the underlying data changes. Dynamic 

sets can only be based on a single dimension. 

To create a dynamic set: 

1. In the Data pane, under Dimensions, right-click a field and select Create > Set.
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2. In the Create Set dialog box, configure your set. You can configure your set using

the following tabs:

• General: Use the General tab to select one or more values that will be considered

when computing the set.

• You can alternatively select the Use all option to always consider all members

even when new members are added or removed.
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• Condition: Use the Condition tab to define rules that determine what members

to include in the set.

• For example, you might specify a condition that is based on total sales that only

includes products with sales over $100,000.
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• Note: Set conditions work the same as filter conditions. See Filter Data from

Your Views to learn more.

• Top: Use the Top tab to define limits on what members to include in the set.

• For example, you might specify a limit that is based on total sales that only

includes the top 5 products based on their sales.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#AddConditions
https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#AddConditions
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• Note: Set limits work the same as Filter limits. See Filter Data from Your

Views to learn more.

1. When finished, click OK.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#AddLimits
https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#AddLimits
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2. The new set is added to the bottom of the Data pane, under the Sets section. A set

icon

1. indicates the field is a set.

Create a fixed set 

The members of a fixed set do not change. A fixed set can be based on a single 

dimension or multiple dimensions. 

To create a fixed set: 

1. In the visualization, select one or more marks (or headers) in the view.

2. Right-click the mark(s) and select Create Set.
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1. In the Create Set dialog box, type a name for the set.

2. Optionally complete any of the following:

• By default, the set includes the members listed in the dialog box. You can select

the option to Exclude these members instead. When you exclude, the set will

include all of the members you didn’t select.

• Remove any dimensions that you don’t want to be considered by clicking the red

“x” icon that appears when you hover over a column heading

• Remove any specific rows that you don’t want to include in the set by clicking the

red “x” icon that appears when you hover over the row
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• If the marks you selected represent multiple dimensions, each member of the set

will be a combination of those dimensions. You can specify the character that

separates the dimension values. To do so, for Separate members by, enter a

character of your choice.

• Select Add to Filters shelf to automatically move the set to the Filters shelf

once it is created.

1. When finished, click OK.

2. The new set is added to the bottom of the Data pane, under the Sets section. A set

icon

1. indicates the field is a set.
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Add or remove data points from sets 

If you created a set using specific data points, you can add more data to or subtract 

data from the set. 

To add or remove data points from a set: 

1. In the visualization, select the data points you want to add or remove.

2. In the tooltip that appears, click the Sets drop-down icon, and then click Add to

[set name] or Remove from [set name] to add or remove data from a

particular set.

Use sets in the visualization 

After you create a set, it displays at the bottom of the Data pane in the Sets section. 

You can drag it into the viz like any other field. 
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When you drag a set to the viz in Tableau Desktop, you can choose to show the 

members of the set or aggregate the members into In/Out categories. 

In Tableau Server or Tableau Online you can only aggregate the members of the set 

into In/Out categories. 

Show In/Out members in a set 

In most cases, when you drag a set to the viz, Tableau displays the set using the 

In/Out mode. This mode separates the set into two categories: 

• In — The members in the set.

• Out — Any members that are not part of the set.

For example, in a set defined for the top 25 customers, the top customers would be 

part of the In category and all other customers would be part of the Out category. 

Using the In/Out mode makes it easy to compare the members in the set to 

everything else. 

To show In/Out members in the visualization: 

• In Tableau Desktop, right-click the set in the visualization workspace and

select Show In/Out of Set.
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When a set is in In/Out mode, the field on the shelf is prefaced by the text, “IN/OUT” 

followed by the set name. 

Note:In/Out mode is not available in workbooks created before version 8.2 that use 

Microsoft Excel or text file data sources, workbooks that use the legacy connection, or 

workbooks that use Microsoft Access data sources. 

Show members in a set 

As an alternative to showing the set using In/Out mode, you can list the members in 

the set. Showing the members in the set automatically adds a filter to the view that 

includes only the members of the set. 
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To switch a set to list the individual members: 

• In the visualization workspace, right-click the set and select Show Members in

Set.

Note: To display the fully qualified member names for cubes, right-click the set in the 

Data pane and select Qualify Member Names. 

Let users change set values 

You can use set actions to give your audience more control over their analysis of your 

visualization. 

Set actions take an existing set and update the values contained in that set based on a 

user’s action in the viz. As the author, you can use a set or sets that you have already 

created to define the scope of the set action. 

For details on how to create and use set actions, see Set Actions. 

Combine sets 

You can combine two sets to compare the members. When you combine sets you 

create a new set containing either the combination of all members, just the members 

that exist in both, or members that exist in one set but not the other. 

Combining sets allows you to answer complex questions and compare cohorts of your 

data. For example, to determine the percentage of customers who purchased both last 

year and this year, you can combine two sets containing the customers from each year 

and return only the customers that exist in both sets. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_sets.htm
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To combine two sets, they must be based on the same dimensions. That is, you can 

combine a set containing the top customers with another set containing the customers 

that purchased last year. However, you cannot combine the top customers set with a 

top products set. 

To combine sets: 

1. In the Data pane, under Sets, select the two sets you want to combine.

2. Right-click the sets and select Create Combined Set.

3. In the Create Set dialog box, do the following

• Type a name for the new combined set.

• Verify that the two sets you want to combine are selected in the two drop-down

menus.

• Select one of the following options for how to combine the sets:

• All Members in Both Sets — the combined set will contain all of the members

from both sets.

• Shared Members in Both Sets — the combined set will only contain members

that exist in both sets.

• Except Shared Members — the combined set will contain all members from

the specified set that don’t exist in the second set. These options are equivalent to

subtracting one set from another. For example, if the first set contains Apples,

Oranges, and Pears and the second set contains Pears and Nuts; combining the

first set except the shared members would contain just Apples and Oranges.

Pears is removed because it exists in the second set.
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• Optionally specify a character that will separate the members if the sets represent

multiple dimensions.

1. When finished, click OK.

Examples of sets 

There are many ways you can use sets to answer complex questions and compare 

cohorts of data. Below are some examples of ways you can use sets to define and 

compare subsets of data. 

How do members of a set contribute to the total? 

You may have all kinds of questions surrounding how the members in a set contribute 

to the overall total. For example, what percent of total sales come from repeat 

customers? You can answer these types of questions using the IN/OUT mode for a set. 

The example below uses sales data to create a set for customers who have purchased 

5,000 USD or more in products. 

Create the set 

1. Right-click (control-click on Mac) the Customer Name dimension in the Data

pane and select Create > Set.
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1. In the Create Set dialog box, type a name for the set. In this example, we’ll call the

set, “Customers”

2. Select the Use all option so the condition always applies to all values even when

new customers are added.

3. On the Condition tab, click By field, and then define a condition that only

includes customers when Sum of Sales is greater than or equal to 5,000.
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1. Click OK.

Create the visualization 

1. Drag the new set from the Sets area at the bottom of the Data pane to

the Rows shelf.

2. From Measures, drag Sales to the Columns shelf. The view now shows the total

sales for customers who have purchased more than 5,000 USD of product and

the total sales for all other customers.
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1. Finally, click on the drop-down arrow on the Sum (Sales) field on the Column

shelf and select Quick Table Calculation > Percent of Total on the context

menu.

The view now shows that customers with sales greater than or equal to 5,000 make up 

about 39% of the overall sales. 

How many members of a set exist in another set? 

Another common use of sets is to compare subsets of data or cohorts. For example, 

you may wonder how many customers that purchased last year also purchased this 

year. Or if a customer purchased a specific product, what other products did they buy? 

You can answer these types of questions by creating multiple sets and combining 

them. The example below uses sales data to determine how many customers who 

purchased in 2012 also purchased in 2013. 

Create a combined set 

1. Drag the Customer Name field to the Rows shelf.

2. Drag the Order Date field to the Filters shelf.

3. In the Filter Field dialog box, select Years and click Next.
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4. In the Filter dialog box, select 2012 and click OK.

1. Back in the view, press CTRL + A (Command-A on a Mac) on your keyboard to

select all of the customers.

2. Right-click (control-click on Mac) the selection and select Create Set.
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1. In the Create Set dialog box that opens, type a name for the set. In this example,

we’ll call the set “Customers (2012)”.

2. Click OK.

3. On the Filters shelf, right-click (control-click on Mac) Order Date and

select Edit Filter.

4. In the Filter dialog box, change the filter to only include 2013 instead of 2012,

and then click OK.

1. Again, press CTRL + A (Command-A on a Mac) on your keyboard to select all of

the customers.

2. In the view, right-click (control-click on Mac) the selection and select Create

Set.

3. In the Create set dialog box that opens, type a name for the set. This set will be

called “Customers (2013)”.

4. Click OK.

5. In the Data pane, select both the Customers 2012 and Customers 2013 by

holding the Ctrl key (Command key on a Mac) on your keyboard as you select.
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6. Right-click (control-click on Mac) the selection and select Create Combined

Set.

1. In the Create Set dialog box, type a name for the new set. In this example, we’ll

call the set “Customers (

2. Select the option to include Shared Members in Both Sets. 

1. Click OK.



 pg. 113 

ITS427 Tableau Certification 

Create the visualization 

1. At the bottom of the workbook, click the New Worksheet

1. icon.

2. In the new worksheet, drag the Customer Name dimension to the Rows shelf.

3. Click the drop-down arrow on the Customer Name field on the Rows shelf and

select Measure > Count (Distinct) from the context menu.

4. Finally, from the Sets area of the Data pane, drag the Customers (2012 &

2013) field to the Filters shelf. You can see that 437 customers purchased

products in both 2012 and 2013.
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Hierarchical sets and descendants 

A hierarchical set filters data to the selected members and all of their descendants. 

They are unique to multidimensional (cube) data sources and are defined within the 

data source prior to connecting to Tableau Desktop. 



 pg. 115 

ITS427 Tableau Certification 

When you create sets in Tableau from a cube data source, descendants and any 

hierarchical structures are automatically included with the selected members. 

For example, a set named Dairy is created from the Product hierarchy. As shown 

below, it includes only the Dairy product department. 

Consider the following view. The Product Department dimension is placed on 

the Rows shelf and the Store Sales measure is placed on the Columns shelf. 



 pg. 116 

ITS427 Tableau Certification 

If you place the Dairy set on the Filters shelf, you can see that the view is filtered to 

include only the Dairy product categories. 

As shown below, you can drill down into Product Department to reveal 

the Product Category, Product Subcategory, and Brand Name levels. As these 
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descendants are revealed, row headers are added to the view. This is because a set 

filter allows you to view the levels of detail contained within the filtered members. 

• Organize dimensions into a hierarchy

When you connect to a data source, Tableau automatically separates date fields into 

hierarchies so you can easily break down the viz. You can also create your own custom 

hierarchies. For example, if you have a set of fields named Region, State, and County, 

you can create a hierarchy from these fields so that you can quickly drill down 

between levels in the viz. 

Create a hierarchy 

To create a hierarchy: 



 pg. 118 

ITS427 Tableau Certification 

1. In the Data pane, drag a field and drop it directly on top of another field.

1. Note: When you want to create a hierarchy from a field inside a folder, right-

click (control-click on a Mac) the field and then select Create Hierarchy.

2. When prompted, enter a name for the hierarchy and click OK.

1. Drag any additional fields into the hierarchy. You can also re-order fields in the

hierarchy by dragging them to a new position.
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• Drill up or down in a hierarchy

1. When you add a field from a hierarchy to the visualization, you can quickly drill

up or down in the hierarchy to add or subtract more levels of detail.

2. To drill up or down in a hierarchy in Tableau Desktop or in web authoring:

• In the visualization, click the + or — icon on the hierarchy field.
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• When you are editing or viewing the visualization on the web, you have the option

of clicking the + or — icon next to a field label.

• Remove a hierarchy



 pg. 121 

ITS427 Tableau Certification 

1. To remove a hierarchy:

• In the Data pane, right-click (control-click on a Mac) the hierarchy and

select Remove Hierarchy.

• The fields in the hierarchy are removed from the hierarchy and the hierarchy

disappears from the Data pane.

• Add a filter to the view

Filtering is an essential part of analyzing data. This article describes the many ways 

you can filter data from your view. It also describes how you can display interactive 

filters in the view, and format filters in the view. 

Filtering Order of Operations 

Before you begin filtering data in Tableau, it’s important to understand the order in 

which Tableau executes filters in your workbook. 

Tableau performs actions on your view in a very specific order; this is called the Order 

of Operations. Filters are executed in the following order: 

1. Extract filters

2. Data source filters

3. Context filters

4. Filters on dimensions (whether on the Filters shelf or in filter cards in the view)

5. Filters on measures (whether on the Filters shelf or in filter cards in the view)
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Select to keep or exclude data points in your view 

You can filter individual data points (marks), or a selection of data points from your 

view. For example, if you have a scatter plot with outliers, you can exclude them from 

the view so you can better focus on the rest of the data. 

To filter marks from the view, select a single mark (data point) or click and drag in the 

view to select several marks. On the tooltip that appears, you can: 

• Select Keep Only to keep only the selected marks in the view.

• Select Exclude to remove the selected marks from the view.
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Note: These filtering options are not available if a Wildcard Match filter is already 

specified for the same field. See Drag dimensions, measures, and date fields to the 

Filters shelf to learn more about Wildcard Match filters. 

Select headers to filter data 

You can also select headers to filter them from your view. 

To filter entire rows or columns of data from your view, select the header in the view. 

On the tooltip that appears, select to Exclude or Keep Only the selected data. 

When you select a table header that is part of a hierarchy, all of the next level headers 

are also selected. For example, the view shown below consists of two unrelated 

dimensions placed on the Columns shelf, and two levels of the same hierarchy 

placed on the Rows shelf. 

The selected row headers include the Furniture member of the Category dimension, 

and the Binders and Labels members of the Sub-category dimension. When 

Furniture is selected, all members from the next (inner) level in the hierarchy are 

automatically selected. In this case, that means the Bookcases, Chairs, Furnishings, 

and Tables members. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#Drag
https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#Drag
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Drag dimensions, measures, and date fields to 

the Filters shelf 

Another way to create a filter is to drag a field directly from the Data pane to the 

Filters shelf. 

In Tableau Desktop, when you add a field to the Filters shelf, the Filter dialog box 

opens so you can define the filter. The Filter dialog box differs depending on whether 

you are filtering categorical data (dimensions), quantitative data (measures), or date 

fields. 

In web authoring, when you add a field to the Filters shelf, an interactive filter 

appears in the view. 



 pg. 125 

ITS427 Tableau Certification 

Filter categorical data (dimensions) 

Dimensions contain discrete categorical data, so filtering this type of field generally 

involves selecting the values to include or exclude. 

In Tableau Desktop 

When you drag a dimension from the Data pane to the Filters shelf in Tableau 

Desktop, the following Filter dialog box appears: 
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There are four tabs in the dialog box: 

• General: Use the General tab to select the values you want to include or exclude.

• Wilcard: Use the Wildcard tab to define a pattern to filter on. For example,

when filtering on email addresses you might want to only include emails from a

specific domain. You can define a wildcard filter that ends with “@gmail.com” to

only include Google email addresses.

• Condition: Use the Condition tab in the Filter dialog box to define rules to filter

by. For example, in a view showing the average Unit Price for a collection of

products, you may want to only show the Products that have an average unit price

that is greater than or equal to $25. You can use the built-in controls to write a

condition or you can write a custom formula.
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• Top: Use the Top tab in the Filter dialog box to define a formula that computes

the data that will be included in the view. For example, in a view that shows the

average Time to Ship for a collection of products, you can decide to only show the

top 15 products by Sales. Rather then having to define a specific range for Sales

(e.g., greater than $100,000), you can define a limit (top 15) that is relative to the

other members in the field (products).

Important Note: Each tab adds additional definitions to your filter. For example, 

you can select to exclude values under the General tab, and also add limits under the 

Top tab. Selections and configurations from both tabs are applied to your filter. 

At any time, you can see the definitions of your filter under Summary on the General 

tab. 

In web authoring 

When you drag a dimension from the Data pane to the Filters shelf in web authoring, 

an interactive filter appears in the view. 

You can then select the items you want to include or exclude in the view. 

Filter quantitative data (measures) 

Measures contain quantitative data, so filtering this type of field generally involves 

selecting a range of values that you want to include. 
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In Tableau Desktop 

When you drag a measure from the Data pane to the Filters shelf in Tableau Desktop, 

the following dialog box appears: 

Select how you want to aggregate the field, and then click Next. 

In the subsequent dialog box, you’re given the option to create four types of 

quantitative filters: 

Range of Values: Select the Range of Values option to specify the minimum and 

maximum values of the range to include in the view. The values you specify are 

included in the range. 

At Least: Select the At Least option to include all values that are greater than or 

equal to a specified minimum value. This type of filter is useful when the data changes 

often so specifying an upper limit may not be possible. 
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At Most: Select the At Most option to include all values that are less than or equal to 

a specified maximum value. This type of filter is useful when the data changes often so 

specifying a lower limit may not be possible. 

Special (Tableau Desktop only): Select the Special option to filter on Null values. 

Include only Null values, Non-null values, or All Values. 

Note: If you have a large data source, filtering measures can lead to a significant 

degradation in performance. It is sometimes much more efficient to filter by creating 

a set containing the measure and then apply a filter to the set. For more information 

about creating sets, see Create Sets. 

In web authoring 

When you drag a measure from the Data pane, to the Filters shelf in web authoring, 

the field is automatically aggregated as a SUM and an interactive filter appears in the 

view. 

To change the aggregation of the filter: 

• On the Filters shelf, right-click the field, select Measure, and then select an

aggregation.

To change the type of quantitative filter in the view: 

• Click the filter card drop-down and select from the following:

• Range of Values: Select the Range of Values option to specify the minimum

and maximum values of the range to include in the view. The values you specify

are included in the range.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/sortgroup_sets_create.htm
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• At Least: Select the At Least option to include all values that are greater than or

equal to a specified minimum value. This type of filter is useful when the data

changes often so specifying an upper limit may not be possible.

• At Most: Select the At Most option to include all values that are less than or

equal to a specified maximum value. This type of filter is useful when the data

changes often so specifying a lower limit may not be possible.

Filter dates 

In Tableau Desktop 

When you drag a date field from the Data pane to the Filters shelf in Tableau Desktop, 

the following Filter Field dialog box appears: 
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You can select whether you want to filter on a relative date; filter between a range of 

dates; or select discrete dates or individual dates to filter from the view. 

• Filter relative dates: Click Relative dates to define a range of dates that

updates based on the date and time you open the view. For example, you may

want to see Year to Date sales, all records from the past 30 days, or bugs closed

last week. Relative date filters can also be relative to a specific anchor date rather

than today.

• Filter a range of dates: Select Range of dates to define a fixed range of dates to

filter. For example, you may want to see all orders placed between March 1, 2009

and June 12, 2009.

• Filter discrete dates: Select a discrete date value in the dialog box if you want

to include entire date levels. For example, if you select Quarters, you can choose



 pg. 132 

ITS427 Tableau Certification 

to filter specific quarters (e.g. Q1, Q2, Q3, Q4) from your view, regardless of the 

year. 

• Latest date preset: If you want to ensure that only the most recent date in a

data source is selected in the filter when the workbook is shared or opened, select

a discrete date such as Month/Day/Year or Individual Dates and then, on the

General tab, select Filter to latest date value when workbook is opened.
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• Notes: When you filter to the latest date value, this setting applies only to data

source filters in a workbook.

• In the order of operations, the latest date filter is global to the workbook, while

context filters apply per worksheet. The latest date is determined just after the

workbook opens for first use, after data source filters, but before context filters.

At that point the date is set, and the latest date preset is used as a dimension

filter.

• If you are using additional filters in views (including relative date filters and

context filters), the latest date value setting may result in an empty view with no

data when those additional filters do not select data from the latest date in the

database.
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• On Tableau Server and Tableau Online, presets are applied when the view first

loads in the browser, but not when the browser or data is refreshed.

• Filter individual dates: Select Individual dates to filter specific dates from

your view.

• Additional date filter options: When you select Relative dates or Range of

dates, the Filter dialog box opens. In that dialog box, you can define a Starting

date or Ending date. You can also select Special to include null dates, non-null

dates, or all dates.

In web authoring 

When you drag a date field from the Data pane to the Filters shelf in web authoring, a 

date range filter appears in the view. 

To change the type of filter, click the filter card drop-down and select from the 

following: 

• Relative Date: Click Relative dates to define a range of dates that updates based

on the date and time you open the view.

• Range of Dates: Select Range of dates to define a fixed range of dates to filter
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• Start Date: Select Start date to define a fixed start date to filter on.

• End Date : Select End date to define a fixed end date to filter on.

• Browse Periods: Select browse periods to select a period of time to filter by,

such as one day, one week, one month, one year, five years, etc.

Filter table calculations 

To create a table calculation filter, create a calculated field, and then place that field 

on the Filters shelf. 

Filters based on table calculations do not filter out underlying data in the data set, 

because table calculation filters are applied last in the order of operations. This means 

Tableau evaluates any table calculations in the view first, and then applies table 

calculation filters on the results in the current view. 

Apply table calculation filter to totals 
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When you show totals in a view and you want a table calculation filter to apply to the 

totals, you can select Apply to totals in the drop-down menu for that filter (on the 

Filters shelf). This option lets you decide when a table calculation filter should be 

applied to totals. 

This options is available when you show totals in the view, and you add a table 

calculation filter to the view. Select Apply to totals to apply the table calculation 

filter to all of the results in the table, including the totals. 
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Display interactive filters in the view 

When an interactive filter is shown, you can quickly include or exclude data in the 

view. 

Note: In web authoring, interactive filters are automatically added to the view when 

you drag a field to the Filters shelf. 

To show a filter in the view: 

1. In the view, click the field drop-down menu and select Show Filter.

Note: In Tableau Desktop, you can add an interactive filter to the view for a field that 

is not currently used in the view. To do so, In the Data pane, click the field drop-down 

menu, and then select Show Filter. 

Set options for filter card interaction and 

appearance 

After you show a filter, there are many different options that let you control how the 

filter works and appears. You can access these options by clicking the drop-down 

menu in the upper right corner of the filter card in the view. 

Some options are available for all types of filters, and others depend on whether 

you’re filtering a categorical field (dimension) or a quantitative field (measure). 
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You can customize how filters appear in the view, in dashboards, or when published 

to Tableau Server or Tableau Online. 

Here are some of the general filter card options: 

• Edit Filter (Tableau Desktop only) — This option opens the main Filter dialog

box so you can further refine the filter by adding conditions and limits.

• Remove Filter (Tableau Desktop only)- Removes the filter from the Filters shelf

and removes the filter card from the view.

• Apply to worksheets — Allows you to specify whether the filter should apply to

only the current worksheet or be shared across multiple worksheets. For more

information, see Apply Filters to Multiple Worksheets.

• Format Filters (Tableau Desktop only) — Customize the font and colors of all

your filter cards in the view.

• Only relevant values — Specifies which values to show in the filter. When you

select this option other filters are considered and only values that pass these

filters are shown. For example, a filter on State will only show the Eastern states

when a filter on Region is set. You can use the toggle at the top of the filter card to

switch between this option and the All Values in Database option.

• All values in hierarchy — Specifies which values to show in the filter. When

you create a filter from a hierarchical field, this option is selected by default. Filter

values are displayed based on relevance of the parent/child relationships in the

hierarchy.

• All values in database — Specifies which values to show in the filter. When you

select this option all values in the database are shown regardless of the other

filters on the view.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering_global.htm
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• All values in context (Tableau Desktop only) — When one of the filters in the

view is a context filter, select this option on a different filter to only display values

that pass through the context filter. For more information, see Improve View

Performance with Context Filters.

• Include values — When this option is selected, the selections in the filter card

are included in the view.

• Exclude values — When this option is selected, the selections in the filter card

are excluded from the view.

• Hide Card (Tableau Desktop only) — Hides the filter card but does not remove

the filter from the Filters shelf.

Filter card modes 

You can control the appearance and interaction of your filter card in the view by 

selecting a filter card mode. 

To select a filter card mode, in the view, click the drop-down menu on the filter card 

and then select a mode from the list. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering_context.htm#f
https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering_context.htm#f
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The types of filter card modes you see in the list of options depend on whether your 

filter is on a dimension or a measure. Below you can find brief descriptions of the 

types of filter card modes available for dimensions and measures. 

For dimensions, you can choose from the following filter modes: 

• Single Value (List): Displays the values of the filter as a list of radio buttons

where only a single value can be selected at a time.

• Single Value (Dropdown): Displays the values of the filter in a drop-down list

where only a single value can be selected at a time.
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• Single Value (Slider): Displays the values of the filter along the range of a

slider. Only a single value can be selected at a time. This option is useful for

dimensions that have an implicit order such as dates.

• Multiple Values (List):Displays the values in the filter as a list of check boxes

where multiple values can be selected.

• Multiple Values(Dropdown): Displays the values of the filter in a drop-down

list where multiple values can be selected.

• Multiple Values (Custom List): Displays a text box where you can type a few

characters and search for the value. Alternatively, you can type or paste a list of

values into the text box to create a custom list of values to include.

• Wildcard Match: Displays a text box where you can type a few characters. All

values that match those characters are automatically selected. You can use the

asterisk character as a wildcard character. For example, you can type “tab*” to

select all values that begin with the letters “tab”. Pattern Match is not case

sensitive. If you are using a multidimensional data source, this option is only

available when filtering single level hierarchies and attributes.

For measures, you can choose from the following filter modes: 

• Range of Values/Dates: shows the filtered values as a pair of sliders that you

can adjust to include or exclude more values. Click on the upper and lower limit

readouts to enter the values manually.

• The darker area inside the slider range is called the data bar. It indicates the

range in which data points actually lie in the view. Use this indicator to determine

a filter that makes sense for the data in your data source. For example, you may

filter the Sales field to only include values between $200,000 and $500,000 but

your view only contains values between $250,000 and $320,000. The range of
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data you can see in the view is indicated by the data bar while the sliders show 

you the range of the filter. 

• Note: Data bars only show in filters where the filtered field is also used in the

view (e.g., on Columns, Rows, or on the Marks card, and son on) and are at the

same aggregation level as the field on the Filters shelf. For example, a filter on

SUM(Sales) will only display data bars if the SUM(Sales) field is used in the view.

It won’t show if AVG(Sales) is used in the view. Even though in both scenarios,

the filtered field, Sales is used in the view; in the latter case the aggregation is

different than the aggregation of the filter.

• At Least/Starting Date: shows a single slider with a fixed minimum value. Use

this option to create a filter using an open ended range.

• At Most/Ending Date: shows a slider with a fixed maximum value. Use this

option to create a filter using an open ended range.

• Relative to Now: this option shows a control where you can define a dynamic

date range that updates based on when you open the view. The option is only

available for filters on continuous date fields.

• Browse periods: shows common date ranges such as past day, week, month,

three months, one year, and five years. This option is only available for filters on

continuous date fields.

Note: When you expose a filter for Measure Values or Measure Names as a single 

value list, selecting All will automatically convert the filter to a multiple values list. 

For information on Measure Values and Measure Names, see Measure Values and 

Measure Names. 

Customize filter cards 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_understanddatawindow_meavalues.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_understanddatawindow_meavalues.htm
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In addition to the general filter options and the filter modes, you control how your 

filter appears in the worksheet, on dashboards, or when published to the web even 

further in Tableau Desktop. 

To customize filters, click the filter card drop-down menu and select Customize. 

You can select from the following options: 

• Show “All” Value — toggles whether to show the “All” option that displays by

default in multiple values and single value lists.

• Show Search Button — toggles whether to show the search button at the top of

the filter.
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• Show Include/Exclude — toggles whether to show the Include Values and

Exclude Values commands on the filter card menu. When shown, users can

switch the filter between include and exclude modes.

• Show Filter Types — toggles whether to let users change the type of quick filter

shown. For example, when shown, a user can change a multiple values list to a

compact list.

• Show More/Fewer button — toggles whether to show the More/Fewer button

• at the top of the filter.

• Show All Values button — toggles whether to display the Show All Values

button

• on the filter card.

• Whenever data is excluded in the filter, the small red “x” appears on the Show All

Values button. When all values are showing, the red “x” disappears.
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• Show Apply Button — toggles whether to show the Apply button at the bottom

of the filter. When shown, changes to the filter are only applied after you click the

button. Pending changes are indicated with a green color. This option is only

available in multiple values lists and dropdowns. This options is available in web

authoring.

• Show Readouts — controls whether the minimum and maximum values are

displayed as text above a range of values. The readouts can be used to manually

type a new value instead of using the sliders.

• Show Slider — controls whether the slider displays. When this option is cleared,

the filter only displays the readouts.

• Show Null Controls — shows a drop-down list that lets you control how the

filter handles null values. You can select from values in a range; values in a range

and null values; null values only, non-null values, or all values.

• Note: Not all of the above options are available for views published to Tableau

Server or Tableau Online.

• Add a context filter

• Add a date filter

Apply analytics to a worksheet 

Drag reference lines, box plots, trend lines forecasts, and other items into your view 

from the Analytics pane, which appears on the left side of the workspace. Toggle 

between the Data pane and the Analytics pane by clicking the tabs at the top of the 

side bar. 
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Tableau Desktop Analytics pane 

In Tableau Desktop, options for adding Analytics objects to the view are available 

the Analytics pane or menu, or in context in the view. For example, reference lines 

and bands are available when you edit an axis, and trend lines and forecasts are 

available from the Analysis menu. 

The Analytics pane provides drag-and-drop access for the various options. 

On the web, most Analytics objects are available from the Analytics pane. 

Add an analytics object to the view 



 pg. 147 

ITS427 Tableau Certification 

To add an item from the Analytics pane, drag it into the view. When you drag an 

item from the Analytics pane, Tableau shows the possible destinations for that item. 

The range of choices varies depending on the type of item and the current view. 

In a simple case, the drop target area would offer these three options: 

The terms Table, Pane and Cell define the scope for the item: 
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For a more complicated view — for example, if the view contained a line chart with 

multiple or dual axes — Tableau would show you a drop target area that looked like 

this: 

If you dropped the item in one of the three larger boxes in the header at the top of the 

drop target area — for example, the Table box — a separate median with quartiles 

would be added for each axis: 

But if you drop the item in any of the six lower boxes aligned with a specific measure, 

the median with quartiles would only be added on the corresponding axis, with the 

specified scope. 

Delete an analytics object from the view 
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You can delete an analytics object from the view by clicking Undo, or drag the object 

off the view to delete it. 

You can also click on an item and choose Remove from the tooltip. 

Note: Some Analytics pane items (Median with Quartiles and Average with 

95% CI) add both a reference line and a reference distribution. Unless you are using 

Undo, you would need to delete these items separately. 

Edit an analytics object in the view 

To edit an item you have added from the Analytics pane, click on the item and 

select Editfrom the tooltip. For additional editing options, see the section for a 

particular item type under Analytics object definitions, below. 

Analytics object definitions 

The following items can be dragged from the Analytics pane and dropped in the 

view. If an analytics object cannot be applied to the current configuration of fields in 

the view, it isn’t available. 

Constant Line 

Adds one or more constant lines to the view. You can add a constant line for a specific 

measure, for all measures, or for date dimensions. When you add a constant line, 

Tableau displays a Value prompt where you specify the value for the constant: 

In Tableau Desktop, the Value prompt for a date value is a calendar control: 
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You can click on a resulting constant line and choose Edit or Remove. In Tableau 

Desktop there is a third option: Format. Choosing Edit opens the Edit Reference 

Line dialog box. For details, see Edit Existing Reference Lines, Bands, and 

Distributions in the Reference Lines, Bands, Distributions, and Boxes article. 

Another way to edit a line in Tableau Desktop is to right-click (control-click on Mac) 

the relevant axis and choose Edit Reference Line. 

Average Line 

Adds one or more average lines to the view. You can add an average line for a specific 

measure or for all measures. 

You can click on a resulting average line and choose a different aggregation, such as 

Total or Sum. You can also choose Edit or Remove. In Tableau Desktop there is a 

third option: Format. Choosing Edit opens the Edit Reference Line dialog box. For 

details, see Edit Existing Reference Lines, Bands, and Distributions in the Reference 

Lines, Bands, Distributions, and Boxes article. Another way to edit a line in 

Tableau Desktop is to right-click (control-click on Mac) the relevant axis and 

choose Edit Reference Line. 

Median with Quartiles 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Edit_Existing_Reference_Lines_and_Bands
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Edit_Existing_Reference_Lines_and_Bands
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Edit_Existing_Reference_Lines_and_Bands
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Adds one or more sets of median lines and distribution bands to the view. You can 

add a median with quartiles for a specific measure or for all measures. 

The distribution bands are computed as quartiles; the middle two quartiles are 

shaded. 

You can click on a resulting median line or distribution and choose Edit or Remove. 

In Tableau Desktop there is a third option: Format. Median lines and distributions 

must be edited, formatted, or removed separately. Choosing Edit opens the Edit 

Reference Line dialog box. You must click on the outer edge of a distribution band to 

see the options — clicking in the middle of the band has no effect. For details, see Edit 

Existing Reference Lines, Bands, and Distributions in the Reference Lines, Bands, 

Distributions, and Boxesarticle. Another way to edit a line or distribution in 

Tableau Desktop is to right-click (control-click on Mac) the relevant axis and 

choose Edit Reference Line. A submenu will offer you two 

choices: Quartiles and Median. 

For information on distribution types, including quartiles, see Add Reference 

Distributions in the Reference Lines, Bands, Distributions, and Boxes article. 

Box Plot 

Adds one or more box plots to the view. You can add box plots for a specific measure 

or for all measures. The scope for a box plot is always Cell (and 

never Table or Pane). 

Click or hover over any of the horizontal lines in the box plot to see statistical 

information about the whiskers, quartiles, and median. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Edit_Existing_Reference_Lines_and_Bands
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Edit_Existing_Reference_Lines_and_Bands
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Add_Reference_Distributions
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Add_Reference_Distributions
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You can also choose Edit or Remove when you click on a line. In Tableau Desktop 

there is a third option: Format. Choosing Edit opens the Edit Reference Line dialog 

box. Another way to edit a box plot in Tableau Desktop is to right-click (control-click 

on Mac) the relevant axis and choose Edit Reference Line. 

Note: In Tableau Desktop, there are two items named Box Plot in the Analytics 

pane. For the Box Plot option in the Summarize section, Tableau will automatically 

add a box plot for the specified target. For the Box Plot option in the Custom section, 

Tableau will open the Edit Reference Line, Band, or Box dialog box after you specify a 

target. 

Totals 

Adds totals to the view. When you add totals, the drop options 

are Subtotals, Column Grand Totals, and Row Grand Totals. 

For details, see Show Totals in a Visualization. 

To remove totals, click the relevant column or row header and choose Remove. 

In Tableau Desktop, you can also click on a totals column or row header after adding 

totals and set the aggregation for that row or column from the tooltip: 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_totals_grandtotal_turnon.htm
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Average with 95% CI 

Adds one or more sets of average lines with distribution bands; the distribution bands 

are configured at a 95% confidence interval. You can add these items for a specific 

measure or for all measures. 

The confidence interval distribution bands shade the region in which the population 

average will fall 95% of the time. 

You can click on a resulting average line or distribution and choose Edit or Remove. 

In Tableau Desktop there is a third option: Format. Choosing Edit opens the Edit 

Reference Line dialog box. The average lines and distributions must be edited, 

formatted, or removed separately. You must click on the outer edge of a distribution 

band to see the options — clicking in the middle of the band has no effect. Another 

way to edit a line or distribution in Tableau Desktop is to right-click (control-click on 

Mac) the relevant axis and choose Edit Reference Line. A submenu will offer you 

two choices: Average and 95% Confidence Interval. 

You can also remove lines and bands by dragging them off the view. 

Median with 95% CI 

Adds one or more sets of median lines with distribution bands; the distribution bands 

are configured at a 95% confidence interval. You can add these items for a specific 

measure or for all measures. 

The confidence interval distribution bands shade the region in which the population 

median will fall 95% of the time. 
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You can click on a resulting median line or distribution and choose Edit, Format, 

or Remove. In Tableau Desktop there is a third option: Format. 

Choosing Edit opens the Edit Reference Line dialog box. The median lines and 

distributions must be edited, formatted, or removed separately. You must click on the 

outer edge of a distribution band to see the options — clicking in the middle of the 

band has no effect. Another way to edit a line or distribution in Tableau Desktop is to 

right-click (control-click on Mac) the relevant axis and choose Edit Reference Line. 

A submenu will offer you two choices: Median and 95% Confidence Interval. 

You can also remove lines and bands by dragging them off the view. 

Trend Line 

Adds one or more trend lines to the view. When you add trend lines, the drop options 

identify the trend line model types available in 

Tableau: Linear, Logarithmic, Exponential, and Polynomial. For some views, 

only a subset of these options is available. 

For details, see Trend Line Model Types 

Click on a trend line to remove or edit it, or to see a statistical definition. You can also 

remove a trend line by dragging it off the view. 

Forecast 

Adds a forecast to the view. This option is only available in Tableau Desktop — not 

when you edit a view on the web. Forecasting is only possible when there is at least 

one measure in the view. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/trendlines_add.htm#modeltype
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Forecasting is not supported for views based on multidimensional data sources. In 

addition, the view cannot contain any of the following: 

• Table calculations

• Disaggregated measures

• Percent calculations

• Grand Totals or Subtotals

• Date values with aggregation set to Exact Date

A time series containing null values also imposes constraints. 

For details, see Forecasting. 

To remove, edit, or read a description of the current forecast, go to the Analysis menu 

and choose Forecast. 

Custom Reference Line 

You can add reference lines for a specific measure or for all measures in the view. 

After you drag a reference line from the Analytics pane and drop it on a target, 

Tableau automatically opens an edit dialog box. See Add a Reference Line in 

the Reference Lines, Bands, Distributions, and Boxes article for information 

on the available options. To return to this dialog box later, click on the line and 

choose Edit. 

Custom Reference Band 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/forecasting.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Add_a_Reference_Line
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You can add reference bands for a specific measure or for all measures in the view. 

After you drag a reference band from the Analytics pane and drop it on a target, 

Tableau automatically opens the Edit Reference Line, Band, or Box dialog box. 

See Add Reference Bands in the Reference Lines, Bands, Distributions, and 

Boxes article for information on the available options. To return to this dialog box 

later, click on the band and choose Edit. You must click on the outer edge of a 

reference band to see the options — clicking in the middle of the band has no effect. 

Custom Distribution Band 

You can add reference distributions for a specific measure or for all measures in the 

view. 

After you drag a reference distribution from the Analytics pane and drop it on a 

target, Tableau automatically opens Edit Reference Line, Band, or Box dialog box. 

See Add Reference Distributions in the Reference Lines, Bands, Distributions, 

and Boxes article for information on the available options. To return to this dialog 

box later, click on the band and choose Edit. You must click on the outer edge of a 

distribution band to see the options — clicking in the middle of the band has no effect. 

Custom Box Plot 

In Tableau Desktop — but not when you edit a view on the web — you can drag a box 

plot from the Custom section of the Analytics pane and drop it on a target. (But keep 

in mind that on the web, you can add a box plot from the Summarize section on the 

Analytics pane.) When you drag Box Plot from the Custom section, Tableau 

automatically opens Edit Reference Line, Band, or Box dialog box. See Add a Box 

Plot in the Reference Lines, Bands, Distributions, and Boxes article for 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Add_Reference_Bands
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Add_Reference_Distributions
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Add_a_Box_Plot
https://onlinehelp.tableau.com/current/pro/desktop/en-us/reference_lines.htm#Add_a_Box_Plot
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information on the available options. The scope for a box plot is always Cell (and 

never Table or Pane). 

Click any of the horizontal lines in the box plot to see statistical information about the 

whiskers, quartiles, and median. 

To return to this dialog box later, click on the band and choose Edit. 

• Add a manual or a computed sort

There are many ways to sort data in a visualization in Tableau. This article 

demonstrates all the ways to sort data in a visualization. 

Sort data on an axis 

A quick way to sort data is to use the sort buttons on an axis. To do so: 

1. In a worksheet, hover over a viz axis.

2. Click the sort icon that appears.

3. One click sorts the data in ascending order. Two clicks sorts it in descending

order. Three clicks clears the sort.
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The sort will update correctly if the underlying data changes. 

Sort specific fields in the viz 

To sort a specific field in the visualization: 

1. In a worksheet, right-click (control-click on Mac) the field you want to sort and

select Sort.

2. Note: You can only sort dimensions.

3. In the Sort dialog box that opens, do the following:

• For Sort order, select one of the following options:
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• Ascending — sorts the data in ascending order from lowest to highest or least to

most.

• Descending — sorts the data in descending order from highest to lowest or most

to least.

• For Sort by, select one of the following options:

• Data source order — the order that the data source naturally orders the data.

Generally for relational data sources, this tends to be in alphabetical order —

more specifically, in natural sort order, which is identical to alphabetical order,

except that multi-digit numbers are ordered as a single character. So, for

example, in alphabetical sorting, “z11” comes before “z2” because “1” is evaluated

as being smaller than “2”, whereas in natural sorting “z2” comes before “z11”

because “2” is evaluated as being smaller than “11”.

• If you are using a cube, this order is the defined hierarchal order of the members

within a dimension.

• Alphabetic — sorts the data alphabetically.

• Note: This sort is case sensitive. It will sort [A-Z] before [a-z].

• To create a non-case sensitive sort, create a calculated field using

the UPPER() or LOWER() functions to transform your strings into a consistent case.

For more information, see String Functions.

• Field — sorts the data based on values in another field. For example, you can

select to sort by the Sales field, using the average aggregation.

• Manual — allows you to manually sort the data in the order you prefer. For

example, if you want to sort high school years in order: Freshman, Sophomore,

Junior, Senior.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/functions_functions_string.htm
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1. When finished, click OK.

2. The visualization updates with the new sorting.

You should keep the following rules in mind when interpreting the sort results: 

• Tableau computes the sort across the entire table using the specified criteria.

SeeSort Data in a Visualization for more information.

• Sorts do not break the dimension hierarchy. Sorted fields are always displayed

within the ordered context already set forth by the fields on the Rows and

https://onlinehelp.tableau.com/current/pro/desktop/en-us/sortgroup_sorting_computed_howto.htm#table
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Columns shelves. This means that Tableau will not rearrange any of the headers 

of the fields that appear before (to the left of) the sorted field. 

• If you want to break the dimension hierarchy when sorting a multidimensional

data source, place only the hierarchy level that you want sorted on the Rows or

Columns shelf.

Sort data using the toolbar 

You can quickly sort data in ascending or descending order using the toolbar. To do 

so: 

• In a worksheet, on the toolbar located just above the Columns shelf, click the

Descending sort icon to sort data from highest/most to lowest/least, or the

Ascending icon to sort data from lowest/least to highest/most.
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Sort data using headers or legends 

You can manually sort data in your visualization by dragging and dropping members 

in a header or legend, such as a color or shape legend. 

To manually sort data using a header: 

• In a worksheet, select a member in a header and drag it up or down.

• The viz updates with the new sort.
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To manually sort data using a legend: 

• In a worksheet, select a member in a legend and drag it up or down.

• The viz updates with the new sort. Notice that the order the data points in the

view appear also updated.
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Create a nested sort 

With the release of Tableau Desktop 2018.2, you can now create a nested sort without 

any additional calculated fields or combined dimensions. 

Suppose you are looking at sales sub-categories for all regions in your country. In the 

view below, you can see that the Central region sells more products in the Chairs 

subcategory than any other subcategory. However it’s harder to compare how Chairs 

ranked in other regions. 

To see which subcategories ranked the highest in each region, you might want to sort 

the subcategories within each region instead. You can do this with nested sorting. 

Set up the view 

1. In Tableau Desktop, open a new workbook and connect to the Sample

Superstoredata source that comes with Tableau.
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2. Navigate to a new worksheet.

3. From Measures, drag Sales to the Columns shelf.

4. From Dimensions, drag Region to the Rows shelf.

5. From Dimensions, drag Sub-Category to the Rows shelf, to the right of the

Region field.

Create a nested sort using the header 

On the worksheet, hover over a viz axis. 
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Click the sort icon that appears at the top of the view. 

One click sorts the data in ascending order. Two clicks sorts it in descending 

order. Threeclicks clears the sort. 
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Now you have a nested sort where the subcategories are listed in descending order of 

sum of sales within each region. You can see that Chairs are the highest selling 

subcategory in the Central region, but in the East region, Phones are the best selling 

product; Chairs are the second-best selling product. 

Create a Nested Sort using the Sort menu 
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Right click on the dimension you wish to sort and select Sort. 

In the Sort dialog, select Nested under Sort By. 

When using the Sort menu to create a nested sort, you can define the field and 

aggregation you wish to sort by. For example, you could sort the view by Profit even if 

Sales is the only measure in the view. 
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It is possible to create a nested sort on both the rows and columns shelves using this 

method. 

Note: When creating a nested sort, the sort will propagate when you drill down 

through the dimensions. For example, a nested sort on Sub-Category will apply to 

Manufacturer and Item if you drill down to that level. 

Sorting with one mark per pane 

If your visualization is only one mark per pane, you can use the same processes as 

above to sort your data. 

Create a Filtered Nested Sort 

When you have dimensions on both the rows and columns shelf, a nested sort on both 

shelves might not produce clear results. The nested sort will apply on the columns 

shelf as if the data on the rows shelf was aggregated, and the nested sort on the rows 

shelf will apply as if the data on the columns shelf was aggregated. 
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Instead of sorting across all fields in a view, we can filter down to a single field and 

maintain the nested sort. 

In the worksheet, hover over the lower viz axis of the dimension member you want to 

sort on. Click the Sort icon that appears next to the Dimension name. 
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The Nested sort will now apply only to that field. 

To remove the Filtered Nested Sort, right click on the Dimension in the rows shelf and 

select Sort. 

In the dialog that appears, click the X next to the filtered field. Then select Apply. 
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• Add a reference line or trend line

You can add a reference line to any continuous axis in the view. 

To add a reference line: 

1. Drag Reference Line from the Analytics pane into the view. Tableau shows

the possible destinations. The range of choices varies depending on the type of

item and the current view.

2. In a simple case, the drop target area offers three options:
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1. The view above is from a web editing session. In Tableau Desktop, the process is

the same but the user interface looks a bit different. The

terms Table, Pane and Celldefine the scope for the item:
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1. For a more complicated view — for example, if the view contains a line chart with

multiple or dual axes — Tableau shows you an expanded drop target area:

1. If you drop the item in one of the three larger boxes in the header (for example,

the Table box), a separate reference line is added for each continuous field in the

view:
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1. But if you drop the item in any of the lower boxes that are aligned with a specific

continuous field, the line is added on the corresponding axis, with the specified

scope.

2. When you drop the line in the target area, Tableau displays a dialog box:

3. Tableau Desktop versionWeb version
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1. The Line option is already selected at the top of the dialog box.

2. Select a continuous field from the Value field to use as the basis for your

reference line. You can also select a parameter.

3. You cannot select a continuous field that isn’t currently in the view as the basis

for your reference line. If you want to use such a continuous field, do the

following:

4. Drag the continuous field from the Data pane to the Details target on the Marks

card.

5. Change the continuous field’s aggregation if necessary.
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6. This will not change the view, but it will allow you to use that continuous field as

the basis for your reference band.

7. Click o the reference line in the view and choose Edit to re-open the Edit

Linedialog box.

8. Select an aggregation. The aggregations that are displayed depend on the

continuous field you select:

• Total — places a line at the aggregate of all the values in either the cell, pane, or

the entire view. This option is particularly useful when computing a weighted

average rather than an average of averages. It is also useful when working with a

calculation with a custom aggregation. The total is computed using the

underlying data and behaves the same as selecting one of the totals option the

Analysis menu.

• Sum — places a line at the SUM of all the values in either the cell, pane, or entire

view.

• Costant- places a line at the specified value on the axis.

• Minimum — places a line at the minimum value.

• Maximum — places a line at the maximum value.

• Average — places a line at the average value along the axis.

• Median- places a line at the median value.

1. Select how you want to label the line:

• None –select this option to not show a label for the reference line.
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• Value — select this option to show a label corresponding to the line’s value on

the axis.

• Computation — select this option to display the name of the continuous field

that is the basis for your reference line and any computation that is performed.

• Custom — select this option to build a custom label in the text box. You can use

the menu to the right of the text box to insert values such as the computation or

the value. You can also type text directly into the box, so you could create a value

such as <Field Name> = <Value>.

1. Specify whether to display the line with a confidence interval, just the line, or just

the confidence interval.

2. Confidence interval distribution bands shade the region in which the population

average will fall n of the time, where n is the value you select in the drop-down on

the right. You can choose one of the listed numeric values or select a parameter:
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1. The higher the value you select, the wider the bands will be.

2. In Tableau Desktop, you can also specify formatting options for the line.

1. Optionally, add a fill color above and below the line.

1. When you are displaying a line and a confidence interval, the shading will be

darker within the confidence interval, and lighter beyond it:
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1. When you are displaying a confidence interval without a line, the fill colors are

disregarded, though your settings are retained and then applied if you decide

later to show a line.

2. Specify whether to Show recalculated line for highlighted or selected

data points. For more information, see Compare marks data with recalculated

lines.

• Use a table calculation

Transform Values with Table Calculations 

Version: 2019.1 Applies to: Tableau Desktop, Tableau Online, Tableau Public, 

Tableau Server 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/data_explore_analyze_interact.htm#RecalcLines
https://onlinehelp.tableau.com/current/pro/desktop/en-us/data_explore_analyze_interact.htm#RecalcLines
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This article explains the basics of table calculations and how to create them in 

Tableau. 

What is a table calculation? 

A table calculation is a transformation you apply to the values in a visualization. Table 

calculations are a special type of calculated field that computes on the local data in 

Tableau. They are calculated based on what is currently in the visualization and do 

not consider any measures or dimensions that are filtered out of the visualization. 

You can use table calculations for a variety of purposes, including: 

• Transforming values to rankings

• Transforming values to show running totals

• Transforming values to show percent of total

For any Tableau visualization, there is a virtual table that is determined by the 

dimensions in the view. This table is not the same as the tables in your data source. 

Specifically, the virtual table is determined by the dimensions within the “level of 

detail,” which means the dimensions on any of the following shelves or cards in a 

Tableau worksheet: 
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The basics: addressing and partitioning 

When you add a table calculation, you must use all dimensions in the level of detail 

either for partitioning (scoping) or for addressing (direction). 

The dimensions that define how to group the calculation (the scope of data it is 

performed on) are called partitioning fields. The table calculation is performed 

separately within each partition. 

The remaining dimensions, upon which the table calculation is performed, are 

called addressing fields, and determine the direction of the calculation. 

Partitioning fields break the view up into multiple sub-views (or sub-tables), and then 

the table calculation is applied to the marks within each such partition. The direction 
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in which the calculation moves (for example, in calculating a running sum, or 

computing the difference between values) is determined by the addressing fields. So 

when you order the fields in the Specific Dimensions section of the Table Calculation 

dialog box from top to bottom, you are specifying the direction in which the 

calculation moves through the various marks in the partition. 

When you add a table calculation using the Compute Using options, Tableau identifies 

some dimensions as addressing and others as partitioning automatically, as a result of 

your selections. But when you use Specific Dimensions, then it’s up to you to 

determine which dimensions are for addressing and which for partitioning. 

Table (across) 

Computes across the length of the table and restarts after every partition. 

For example, in the following table, the calculation is computed across columns 

(YEAR(Order Date)) for every row (MONTH(Order Date)). 
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Table (down) 

Computes down the length of the table and restarts after every partition. 

For example, in the following table, the calculation is computed down rows 

(MONTH(Order Date)) for every column (YEAR(Order Date)). 

Table (across then down) 

Computes across the length of the table, and then down the length of the table. 

For example, in the following table, the calculation is computed across columns 

(YEAR(Order Date)), down a row (MONTH(Order Date)), and then across columns 

again for the entire table. 
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Table (down then across) 

Computes down the length of the table, and then across the length of the table. 

For example, in the following table, the calculation is computed down rows 

(MONTH(Order Date)), across a column (YEAR(Order Date), and then down rows 

again. 
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Pane (down) 

Computes down an entire pane. 

For example, in the following table, the calculation is computed down rows 

(MONTH(Order Date)) for a single pane. 
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Pane (across then down) 

Computes across an entire pane and then down the pane. 

For example, in the following table, the calculation is computed across columns 

(YEAR(Order Date)) for the length of the pane, down a row (MONTH(Order Date)), 

and then across columns for the length of the pane again. 
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Pane (down then across) 

Computes down an entire pane and then across the pane. 

For example, in the following table, the calculation is computed down rows 

(MONTH(Order Date)) for the length of the pane, across a column (YEAR(Order 

Date)), and then down the length of the pane agian. 
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Cell 

Computes within a single cell. 
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Specific Dimensions 

Computes only within the dimensions you specify. 

For example, in the following visualization the dimensions, Month of Order Date and 

Quarter of Order Date, are the addressing fields (since they are selected), and Year of 

Order Date is the partitioning field (since it is not selected). So the calculation 

transforms the difference from each month across all quarters within a year. The 

calculation starts over for every year. 

Note that if all dimensions are selected, then the entire table is in scope. 

At the level 

The At the level option is only available when you select Specific Dimensions in 

the Table Calculations dialog box, and when more than one dimension is selected in 
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the field immediately below the Compute Using options — that is, when more than 

one dimension is defined as an addressing field. 

This option is not available when you’re defining a table calculation with Compute 

Using, because those values establish partitions by position. But with Specific 

Dimensions, because the visual structure and the table calculation are not 

necessarily aligned, the At the level option is available to let you fine-tune your 

calculation. 

Use this setting to set a break (that is, restart of the calculation) in the view, based on 

a particular dimension. How is this different from just using that dimension for 

partitioning? In fact, it is partitioning, but it’s partitioning by position rather than by 

value, which is how partitioning is defined with the Compute Using options. 

The choices available from the At the level drop-down list in the example above are: 

DeepestSpecifies that the calculation should be performed at the level of finest 

granularity. This is the default option.Quarter of Order DateSpecifies that the 

calculation should be performed at the quarter level.Month of Order Date 

Specifies that the calculation should be performed at the month level. 

Create a table calculation 

To learn how to create a table calculation, follow along with the steps in the example 

below. To learn how to create quick table calculations, see Quick Table Calculations. 

Step 1: Build the visualization 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_tablecalculations_quick.htm
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1. Open Tableau and connect to the Sample-Superstore saved data source.

2. Navigate to a new worksheet.

3. From the Data pane, under Dimensions, drag Order Date to the Rows shelf.

4. The dimension updates to YEAR(Order Date).

5. On the Rows shelf, right-click YEAR(Order Date) and select Quarter.

6. On the Rows shelf, click the + icon on QUARTER(Order Date).

7. MONTH(Order Date) is added to the shelf.

8. From the Data pane, under Dimensions, drag Order Date to

the Columns shelf.

9. The dimension updates to YEAR(Order Date) again.

10. From the Data pane, under Measures, drag Sales to Text on the Marks card.

11. The updates to look like this:
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Step 2: Add the table calculation 

1. On the Marks card, right-click SUM(Sales) and select Add Table Calculation.

2. In the Table Calculation dialog box that opens, do the following:

• For Calculation Type: select Difference From.

• For more information about the types of table calculations you can use in

Tableau, and how you can configure them, see Table Calculation Types.

• For Compute Using, select Table (across).

• For more information about these options, see The basics: addressing and

partitioning section.

• Note that as you select how to compute the calculation, the visualization updates

with visual indicators to guide you.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_tablecalculations_definebasic_runningtotal.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_tablecalculations.htm#Basics
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_tablecalculations.htm#Basics
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• When finished, click the X in the top corner of the Table Calculation dialog box to

exit it.

• The calculation is applied to the values in the visualization.

Check your work! 

Edit a table calculation 

To edit a table calculation: 

1. Right-click the measure in the view with the table calculation applied to it and

select Edit Table Calculation.

2. In the Table Calculation dialog box that appears, make your changes.
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3. When finished, click the X in the top corner of the Table Calculation dialog box to

exit it.

Remove a table calculation 

To remove a table calculation: 

• Right-click the measure in the view with the table calculation applied to it and

select Clear Table Calculation.

• The table calculation is removed from the measure and the visualization updates

with the original values.

• Use bins and histograms

Sometimes it’s useful to convert a continuous measure (or a numeric dimension) into 

bins. 

Any discrete field in Tableau can be considered as a set of bins. For example, suppose 

you create a view with Profit on Rows and State on Columns. You could consider 

the State field as a set of bins — each profit value is sorted into a bin corresponding 

to the state from which the value was recorded. But if you want to see values 

for Profit assigned to bins without reference to a dimension, you can create a 

numeric bin, with each individual bin corresponding to a range of values. 

Note: You can bin data only for relational data sources and binned fields cannot be 

used in calculations. However, it is possible to create a calculated field that will 

replicate a bin of a specific size. For example: (FLOOR([Sales]/1000)*1000) will create 

bins with a size of 1000. By dragging this calculation to the dimensions pane, you can 

use these bins with cube data sources and calculated fields. 
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When you create bins from a measure you create a new dimension. That’s because 

you are creating a field with a limited and discrete set of possible values out of a field 

with an unlimited, continuous range of values. However, once the dimension is 

created, you can convert it to a continuous dimension. This can be useful, for 

example, if you want to create a histogram. See Create a Histogram from a Binned 

Dimension. 

Create a Binned Dimension: 

1. In the Data pane, right-click (control-click on Mac) a measure and

select Create > Bins.

1. In the Create Bins dialog box, accept the proposed New field name or specify a

different name for the new field.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_bins.htm#CreateHisto
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_bins.htm#CreateHisto
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1. On the web, the dialog box is named Edit Bins and has a slightly different

appearance, but the options are the same.

2. Either enter a value in the Size of bins field or have Tableau calculate a value for

you.

3. If Tableau can perform the optimizing calculation quickly enough, the value you

see initially in Size of bins is Tableau’s estimate of the optimal bin size.

4. If Tableau cannot perform the optimizing calculation quickly, the Size of

bins field defaults to 10. In this case you can click Suggest Bin Size to have

Tableau perform the optimizing calculation.

5. The formula that Tableau uses to calculate an optimal bin size is

6. Number of Bins = 3 + log2(n) * log(n)

7. In the formula, n is the number of distinct rows in the table. The size of each bin

is determined by dividing the difference between the smallest and the largest

values by the number of bins.
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The four read-only fields in the lower part of the Create Bins dialog box show you the 

data that Tableau uses to suggest a bin size. You can also consider these values if you 

want to set a bin size manually. The values are: 

MinThe field’s minimum value.MaxThe field’s maximum value.DiffThe difference 

between the field’s minimum and maximum values.CntDThe number of distinct 

values (rows) in the data. 

After you click OK to dismiss the Create Bins dialog box, a new binned field appears 

in the Dimensions area of the Data pane. 

When you add a binned dimension to the view, each bin acts as an equal-sized 

container that summarizes data for a specific range of values. Column or row headers 

are created, where each bin label designates the lower limit of the range of numbers 

that is assigned to the bin. Note that the lower limit is inclusive. 
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Create a Histogram from a Binned Dimension 

If you create a binned dimension, you can use it as the starting point for creating a 

histogram. Using the Sales (bin) dimension created according to the instructions 

above, use the following steps to create a histogram. 

Note: A quicker way to create a histogram is using Show Me. See Build a 

Histogram in the Build-It-Yourself Exercises section for information on creating a 

histogram using Show Me. 

1. Click the Sales (bin) dimension in the Data pane and choose Convert to

continuous.

2. Drag the Sales (bin) dimension from the Data pane and drop it on

the Columnsshelf.

3. Drag the original Sales field from the Measures area of the Data pane and drop it

on the Rows shelf.

4. Click SUM(Sales) on Rows and change the aggregation from Sum to Count.

The result is a histogram: 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/buildexamples_histogram.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/buildexamples_histogram.htm


 pg. 200 

ITS427 Tableau Certification 

• Create a calculated field (e.g. string, date, simple arithmetic)

Sometimes your data source does not contain a field (or column) that you need for 

your analysis. For example, your data source might contain fields with values for Sales 

and Profit, but not for Profit Ratio. If this is the case, you can create a calculated field 

for Profit Ratio using data from the Sales and Profit fields. 

This topic demonstrates how to create a simple calculated field using an example. 

Step 1: Create the calculated field 
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1. In a worksheet in Tableau, select Analysis > Create Calculated Field.

2. In the Calculation Editor that opens, give the calculated field a name.

3. In this example, the calculated field is called Profit Ratio.

Step 2: Enter a formula 

1. In the Calculation Editor, enter a formula.

2. This example uses the following formula:

3. SUM([Profit])/SUM([Sales])

4. Formulas use a combination of functions, fields, and operators. To learn more

about creating formulas in Tableau, see Formatting Calculations in

Tableau and Functions in Tableau.

5. When finished, click OK.

6. The new calculated field is added to the Data pane. If the new field computes

quantitative data, it is added to Measures. If it computes qualitative data, it is

added to Dimensions.

7. You are now ready to use the calculated field in the view.

Check your work! Watch how to create a simple 

calculated field in action: 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/functions_operators.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/functions_operators.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/functions.htm
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See Also 

• Add a parameter Sharing Insights

Parameters are useful when you want to add interactivity and flexibility to a report, or 

to experiment with what-if scenarios. Suppose you are unsure which fields to include 

in your view or which layout would work best for your viewers. You can incorporate 

parameters into your view to let viewers choose how they want to look at the data. 

When you work with parameters, consider the following two things that are important 

in making them useful: 

• They need to be used in calculations.

• The parameter control needs to be displayed so that viewers can interact with it.
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Before you begin, decide which fields you want to make interactive. For example, you 

could allow users to view the categories within a dimension by color, or to view sales 

data over a period of time that they choose, and so on. The example described here 

sets up a table for which users can select the dimensions to display in the columns and 

rows. 

Tip: To learn how to create parameters for what-if and other common scenarios, see 

the on-demand training video Parameters on the Tableau website. Also see Use 

Parameters to Add Multiple Views to Your Viz and Using a parameter to change the 

view in a dashboard. 

Create the parameters and calculated fields 

These steps use the Superstore sample to create a new parameter while you build the 

calculated field that will take advantage of it. 

1. Select Analysis > Create Calculated Field.

2. In the Calculated Field dialog box, for Name, type Column 1 Category.

3. Next to Parameters, click Create, and in the Create Parameter dialog box,

complete the following steps:

4. Name the parameter appropriately so that viewers can tell what changing it will

do. This example uses Select Column 1 Heading.

5. For Data type, select String.

6. For Allowable Values, select List, type None as the first value in the list, and

then press Enter.

http://www.tableau.com/learn/tutorials/on-demand/parameters
http://www.tableau.com/about/blog/2015/7/lrtt-parameters-alter-your-viz-40767
http://www.tableau.com/about/blog/2015/7/lrtt-parameters-alter-your-viz-40767
http://www.thedataschool.co.uk/bethany-fox/tableau-tip-2-using-parameter-change-view-dashboard-part-1/
http://www.thedataschool.co.uk/bethany-fox/tableau-tip-2-using-parameter-change-view-dashboard-part-1/
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7. Complete the list by typing the names of the additional dimension fields that you

want to expose through the parameter.

8. Note: This example uses the customer name, customer segment, region,

department, and category fields. These are all dimensions of the same data type

(string). If you wanted to include a measure such as profit in this list, one option

would be to convert the measure to a string value. You would do this when you

build the calculated field, using the STR() function. This article covers only the

single data type scenario.

9. The Display As aliases default to the field name, and for this exercise you can

leave them as they are.

1. Click OK to return to the Calculated Field dialog box.

2. Repeat the previous step to create the following additional parameters:
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• Select Column 2 Heading

• Select Row 1 Heading

• Select Row 2 Heading

1. Tip: Instead of typing each value in the list, click Add from Parameter to add

them from Select Column 1 Heading.

2. In the Calculated Field dialog box, for Formula, build the following calculation:

3. CASE [Select Column 1 Heading]

WHEN 'Customer Name' THEN [Customer Name] 

WHEN 'Customer Segment' THEN [Customer Segment] 

WHEN 'Region' THEN [Region] 

WHEN 'Department' THEN [Department] 

WHEN 'Category' THEN [Category] 

ELSE '' 

END
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1. Confirm that the status message indicates that the formula is valid, and then

click OK.

2. Note: ELSE accounts for the None value that you included in the parameter,

and it returns an empty string.

3. Create three more calculated fields, one for each of the additional parameters you

created:

4. Parameter nameCalculated field nameSelect Column 2 HeadingColumn 2

CategorySelect Row 1 HeadingRow 1 CategorySelect Row 2 HeadingRow 2

Category

5. The basic formula for each calculated field is the same as in the previous step,

except that you reference a different parameter in each CASEstatement.

Give viewers a way to interact with views 

Next, expose the parameter control so users can select the categories they want to 

display. 

1. For each parameter you created, do the following:

2. In the Parameters pane, right-click the parameter and select Show Parameter

Control.
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1. From the Dimensions pane, drag the calculated fields you created to the Columns

and Rows shelves.

2. From the Measures pane, drag a measure to the view. In this example, Sales is

placed on Label on the Marks card.

3. Test your parameters by selecting fields in the parameter controls.

4. Tips:

• Sort the dynamic dimension fields alphabetically.

• Hide field labels for rows and columns.

1. Reset all parameters to None and publish the workbook to Tableau Server.
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1. Viewers can set up their own reports, save their parameter settings, and share

views with others.

Part 3: Sharing Insights 

• Use color

Categorical Palettes 

When you drop a field with discrete values (typically a dimension) on Color on 

the Markscard, Tableau uses a categorical palette and assigns a color to each value of 

the field. Categorical palettes contain distinct colors that are appropriate for fields 

with values that have no inherent order, such as departments or shipping methods. 

To change colors for values of a field, click in the upper-right corner of the color 

legend. In Tableau Desktop, select Edit Colors from the context menu. In Tableau 

Server or Tableau Online, the Edit Colors dialog opens automatically. 

Tableau Desktop versionWeb version 
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Change the color for a value 

1. Click on an item on the left, under Select Data Item.

2. Click a new color in the palette on the right. In Tableau Desktop you can hover

over a swatch to identify the color.

3. Repeat for as many values that you want to change.
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4. In Tableau Desktop, click OK to exit the Edit Colors dialog box. In Tableau Server

or Tableau Online, simply close the dialog box.

Select a different palette 

The Select Color Palette drop-down list in the Edit Colors dialog box provides color 

palettes that you can use for discrete fields. The list contains both categorical and 

ordinal palettes. 

At the top of the list are categorical palettes, such as Tableau 10. As noted above, 

categorical palettes are appropriate for discrete fields with no inherent order. 

At the bottom of the list are ordinal palettes such as Orange. Ordinal palettes contain 

a range of related colors and are appropriate for fields that have an associated order, 

such as dates or numbers. 

After you select a palette, click Assign Palette to automatically assign the new 

palette colors to the members in the field. 

To return to the Automatic palette and the default color assignments, click Reset in 

the Edit Colors dialog box. 

Quantitative Palettes 

When you drop a field with continuous values on the Marks card (typically a 

measure), Tableau displays a quantitative legend with a continuous range of colors. 
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You can change the colors used in the range, the distribution of color, and other 

properties. To edit colors, click in the upper right of the color legend. In Tableau 

Desktop, select Edit Colors from the context menu. In Tableau Server or Tableau 

Online, the Edit Colors dialog opens automatically. 

When there are both negative and positive values for the field, the default range of 

values will use two color ranges and the Edit Colors dialog box for the field has a 

square color box on either end of the range. This is known as a diverging palette. 

Tableau Desktop versionWeb version 
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Edit Colors dialog box for a diverging palette 

When all values are either positive or negative, the default range of values will use a 

single color range and the Edit Colors dialog box for the field has a square color box 

only at the right end of the range. This is known as a sequential palette. 

Tableau Desktop versionWeb version 

Edit Colors dialog box for a sequential palette 
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You can specify whether Tableau uses a diverging or a sequential palette for a 

continuous field on Color, and also configure the range of colors for the field’s values. 

The Palette drop-down list provides a range of color palettes from which you can 

choose. There are two types of quantitative palettes available for continuous fields: 

• All palettes with Diverging in the name are diverging quantitative palettes — for

example, Orange-Blue Diverging. You can choose a diverging palette for any

continuous field — it isn’t necessary for the range of values to contain both

positive and negative numbers.

• To change the colors for a diverging palette, click one of the square color boxes at

either end of the palette spectrum. Depending on whether you are authoring in

Tableau Desktop or on the web, do one of the following:

• In Tableau Desktop, in the color configuration dialog box (which is part of your

computer’s operating system), select a color from the color picker or enter custom

values.

• In Tableau Server or Tableau Online, enter a custom Hex value in the Custom

Color field. If the value isn’t valid, no changes are made.

• All other palettes are sequential quantitative palettes. To change the colors for a

sequential palette, click the square color box at the right end of the palette

spectrum to either open the color configuration dialog box (Tableau Desktop), or

enter a custom Hex value in the Custom Color field (Tableau Server or Tableau

Online).

Options for quantitative palettes 
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The following options are available in the Edit Colors dialog box for a continuous 

field. 

Note: Options differ where noted for Tableau Server and Tableau Online. 

Stepped Color 

Select Stepped Color to group values into uniform bins, where each bin is 

associated with a color. Use the spin control to specify how many steps (bins) to 

create. For example, for a range of values from 0 to 100 you could specify five steps to 

sort values into five bins (0–20, 20–40, etc.). 

Tableau Desktop versionWeb version 
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If a diverging color palette is selected, the point where the palette transitions between 

colors is shown on the color ramp with a small black tick mark. When the number of 

steps is odd, the mark is placed in the middle of the transitional step. When the 

number of steps is even, the mark is placed at the boundary between the steps where 

the color changes. 

Reversed 

Select Reversed to invert the order of colors in the range. For example, if you want 

lower values to have a darker intensity in a sequential palette, reverse the palette. For 

a diverging palette, reversing the color palette means swapping the two colors in the 

palette, in addition to inverting the shades within each color range. 

Use Full Color Range 

With a diverging (two-color) palette, you can select to Use Full Color Range. 

Tableau assigns both the starting number and the ending number a full intensity for 

both color ranges. So if the range is from -10 to 100, the color representing negative 

numbers will be adjusted to change in shade much more quickly than the color 

representing positive numbers. If you don’t select Use Full Color Range, Tableau 
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assigns the color intensity as if the range of values was from -100 to 100, so that the 

change in shade is the same on both sides of zero. This means there will be much less 

change on the negative side, where actual values only range from -10 to 0, than on the 

positive side, where values range from 0 to 100. 

The image on the left below shows a red-green diverging color palette for values from 

-858 to 72,986. Without using the full color range, -858 (associated with the small

box at the lower right of the chart) shows as gray, because -858 is only about 1% as far 

to the negative side as 72,986 is to the positive side. When the full color range is used, 

as in the image on the right, -858 shows as a dark red, equal in intensity to the 

maximum positive value. 

Include totals 

Select Include Totals to include totals, sub-totals and grand totals in the color 

encoding. This option only applies when total values are included in the view. 

Limit the color range 

In Tableau Desktop, when you click Advanced in the Edit Colors dialog box, you can 

choose to specify the start, end, and center values for the range by selecting the check 

box and typing a new value into the field and the color ramp is adjusted accordingly. 
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The Start value is the lower limit in the range, the End value is the upper limit, and 

the Center value is where the neutral color is located on a diverging color palette. 

Note: This option is not currently available in Tableau Server or Tableau Online. 

Reset the color range 

To return to the Automatic palette and the default color assignments, click Reset in 

the Edit Colors dialog box. 

Note: If you are in web authoring mode and click Reset, the color palette will return 

to the default settings. Any options that were set in the Advanced option will also be 

reset. To undo this action, you can click Undo in the top menu. If your changes have 

already been saved, you must change the Advanced options in Tableau Desktop and 

republish the view. 

Configure Color Effects 

Click the Color drop down on the Marks card to configure additional Color settings 

not related to the actual colors shown. 

Tableau Desktop versionWeb version 
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Opacity 

Modify the opacity of marks by moving the slider. 

Adjusting opacity is especially useful in dense scatter plots or when you are looking at 

data overlaying a map or background image. As you slide the slider toward the left, 

marks become more transparent. 
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Mark borders 

By default, Tableau displays all marks without a border. You can turn on mark 

borders for all mark types except text, line, and shape. On the Color drop-down 

control, select a mark border color. 

Tableau Desktop versionWeb version 
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Borders can be useful for visually separating closely spaced marks. For example, the 

views below show a scatterplot with mark borders turned on (left) and turned off 

(right). When borders are turned on, marks are easier to distinguish in areas where 

they are tightly clustered. 

Note: You can also use the opacity setting to show the density of marks. 
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When you are viewing a large number of color-encoded small marks, it is usually 

better to leave mark borders off. Otherwise borders can dominate the view, making it 

difficult to see the color encoding. 

For example, the views below show bars that are segmented by a large number of 

color-encoded dimension members. With mark borders turned on (right), some of the 

narrower marks are difficult to identify by color. With borders turned off (left), the 

marks are easy to distinguish. 

Mark halos 

To make marks more visible against a background image or map, surround each mark 

with a solid contrasting color called a halo. Mark halos are available when you have a 
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background image or a background map. On the Color drop-down control, select a 

mark halo color. 

Markers 

In Tableau Desktop, when you are using the Line mark type, you can add a marker 

effect to show or hide points along the line. You can show selected points, all points, 

or no points. On the Color drop-down control, select a marker in the Effects section. 

Note: This option is not currently available in Tableau Server or Tableau Online. 

• Use bolding
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Calculated fields just generate text. The formatting can be done in the container 

holding the text. E.g. if this will be in a tooltip, insert Customer Num into tooltip, then 

select and use the editor to format (color, font, bold….). 

• Use shapes

Custom shapes in Tableau are fast and easy to use and provide the user unlimited 

control over mark shapes. Tableau shapes and controls can be found in the marks 

card to the right of the visualization window. There are plenty of options built into 

Tableau that can be found in the shape palette, but what if you want to use custom 

shapes for effect, branding, etc.? 

To select additional shapes, click “more shapes”, and the window you will see looks 

like this: 

There is a folder in “My Documents” called “My Tableau Repository” where you can 

find a shapes folder. Within this shapes folder, simply create a new folder for your 
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shapes and name it an informative name. Save any custom shapes you would like to 

use in your visualization into this file. 

To load your shapes, hit reload in your shapes palette and then select the new shapes 

folder from the drop down menu. 

Here you can see our custom produce folder where we are going to assign vegetable 

shapes to our scatter plot. Our scatter plot has a category, “regions”, that has four 

classes that we have assigned each a single shape. 

Custom shapes are powerful when telling a story with your visualizations. You can 

create unlimited shape combinations to show mark points and create custom 

formatting. 
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Be careful, however, to not over use shapes. The customization is available to help 

better inform your reader and over involving custom shapes can convolute your end 

visualization and hinder your end-user from interpreting the data correctly and 

efficiently. It is best practice to always check Tableau’s shapes before importing 

custom shapes; years of research have gone into Tableau’s selection of custom shapes 

based on industry best practices. 

• Change size of marks

Change the size of marks 

To change the size of marks in the view, do one of the following: 

• On the Marks card, click Size, and then move the slider to the left or right.

• The Size slider affects different marks in different ways, as described in the

following table.

• MARK TYPEDESCRIPTIONCircle, Square, Shape, TextMakes the mark bigger or

smaller.Bar, Gantt BarMakes bars wider or narrower.LineMakes lines thicker or
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thinner.PolygonYou cannot change the size of a polygon.PieMakes the overall size 

of the pie bigger and smaller. 

• The size of your data view is not modified when you change marks using

the Sizeslider. However, if you change the view size, the mark size might change

to accommodate the new formatting. For example, if you make the table bigger,

the marks might become bigger as well.

• From the Data pane, drag a field to Size on the Marks card.

When you place a discrete field on Size on the Marks card, Tableau separates the 

marks according to the members in the dimension, and assigns a unique size to each 

member. Because size has an inherent order (small to big), categorical sizes work best 

for ordered data like years or quarters. 
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Size-encoding data with a discrete field separates the marks in the same way as 

the Detail property does, and then provides additional information (a size) for each 

mark. For more information, see Separate marks in the view by dimension members . 

When you add categorical size encoding to a view, Tableau displays a legend showing 

the sizes assigned to each member in the field on the Size target. You can modify how 

these sizes are distributed using the Edit Sizes dialog box. 

When you place a continuous field on Size on the Marks card, Tableau draws each 

mark with a different size using a continuous range. The smallest value is assigned the 

smallest sized mark and the largest value is represented by the largest mark. 

When you add quantitative size encoding to the view, Tableau displays a legend 

showing the range of values over which sizes are assigned. You can modify how these 

sizes are distributed using the Edit Sizes dialog box. 

Edit marks sizes 

To edit the size of marks, or change how size is being applied to marks in the view: 

1. On the Size legend card (which appears when you add a field to Size on the Marks

card), click the drop-down arrow in the right-hand corner and select Edit Sizes.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/viewparts_marks_markproperties.htm#DetailProp
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1. For more information about legends, see Legends.

2. In the Edit Sizes dialog box that appears, make your changes and then click OK.

3. The options available depend on whether the field being applied to Size is a

continuous or discrete field.

4. For continuous fields, you can do the following:

• For Sizes vary, click the drop-down box and select one of the following:

• Automatically — Selects the mapping that best fits your data. If the data is

numeric and does not cross zero (all positive or all negative), the From zero

mapping is used. Otherwise, the By range mapping is used.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/view_parts.htm#Legends
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• By range — Uses the minimum and maximum values in the data to determine

the distribution of sizes. For example, if a field has values from 14 to 25, the sizes

are distributed across this range.

• From zero — Sizes are interpolated from zero, assigning the maximum mark

size to the absolute value of the data value that is farthest from zero.

• Use the range slider to adjust the distribution of sizes. When the From zero

mapping is selected from the Sizes vary drop-down menu, the lower slider is

disabled because it is always set to zero.

• Select Reversed to assign the largest mark to the smallest value and the smallest

mark to the largest value. This option is not available if you are mapping sizes

from zero because the smallest mark is always assigned to zero.

• To modify the distribution of sizes, select the Start value in legend and End

value for range check boxes and type beginning and end values for the range.

• For discrete fields, you can do the following:

• Use the range slider to adjust the distribution of sizes.
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• Select Reversed to assign the largest mark to the smallest value and the smallest

mark to the largest value.

• Select fonts

Format fonts 

Select Format > Font . A Format Font control pane will open. This control pane 

will let you customize the text in the view. 

Click the letters below for more information. 
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Create and modify a dashboard 

• Create a dashboard layout

Open a dashboard sheet 

You create a dashboard in much the same way you create a new worksheet. After you 

create a dashboard you can add views and objects. 

To open a new dashboard sheet and start creating a dashboard, click the New 

Dashboardicon at the bottom of the workbook: 

The Dashboard area appears on the left and lists the sheets in your workbook. 
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Add views 

After you have a dashboard sheet, click the views you built (listed under Sheets on 

the left) and drag them to your dashboard sheet on the right. A gray, shaded area 

indicates where you can drop views: 

Click the image to replay it. 

Add and edit objects 

In addition to adding views to your dashboard, you can add objects that add visual 

appeal and interactivity. Here’s guidance about each type: 
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• Horizontal and Vertical objects provide layout containers that let you group

related objects together and fine-tune how your dashboard resizes when users

interact with them.

• Web Page objects display target pages in the context of your dashboard. Be sure

to review these web security options, and be aware that some web pages don’t

allow themselves to be embedded — Google is one example.

• Blank objects help you adjust spacing between dashboard items.

• Button objects let your audience navigate from one dashboard to another, or to

other sheets or stories. Add custom images and tooltip text to reveal a button’s

destination to your users.

• Image objects add to the visual flavor of a dashboard, and you can link them to

specific target URLs.

• Extension objects let you add unique features to dashboards or integrate them

with applications outside Tableau.

Add an object 

Select an item under Objects on the left, and drag it to the dashboard sheet on the 

right: 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_refine.htm#Use_a_layout_container
https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_best_practices.htm#Be_security-savvy
https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboard_extensions.htm
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Edit an object 

Click the object container to select it. Then click the arrow in the upper corner to open 

the shortcut menu. (The menu options vary depending on the object.) 

Add interactivity 

Part of the power of dashboards is that you can set up filters and interactivity to 

associate the different views on your sheet and enhance your users’ analysis. The 

people looking at your dashboard can stay in a single spot — they don’t need to click 

outside the world you’ve created for them. 

In a dashboard you can use the Use as Filter option to make one of the views act as a 

filter on all the other views in the dashboard. To do this, select the filter button. 
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If you’re using Tableau Desktop, there are many other actions you can add to your 

dashboard. For details, see Actions and Dashboards and Using Field and Filter Values 

in Actions. 

Edit a web dashboard (Tableau Server and 

Tableau Online only) 

On the Views page in Tableau Server or Tableau Online, you can open a dashboard for 

editing in the following ways: 

• In list view, select the check box for the dashboard, then select Actions > Edit

Sheet.

• Click a dashboard to open it, and then click Edit.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_dashboards.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_fieldvalues.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_fieldvalues.htm
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• Note: If you don’t see the Edit option, ask the content owner or your

administrator for web editing permissions. (The Save options available to you

also depend on your permissions.)

Although it’s possible to edit a workbook that has device layouts, it’s not advised. 

Because device layouts inherit their content, formatting, and action from the parent 

(that is, from the default dashboard), editing the default dashboard can impact a 

device layout. You’ll be able to see any issues in a device layout, but because device 

layouts are read-only, you won’t be able to edit it. To edit a dashboard that has device 

layouts, download the dashboard to Tableau Desktop and make your edits there. 

• Add interactive or explanatory elements

• Add dashboard actions

Actions often have unique behavior when the source or destination is a dashboard. 

Because a dashboard can contain multiple views, a single filter or highlight action can 

have broad impact. Dashboards can also contain web page objects, which you can 

target with interactive URL actions. 

Use a single view to filter other views in a 

dashboard 

Imagine you have a dashboard that contains three views about profitability: a map, a 

bar chart, and a table of customer names. You can use a filter action to make one of 
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the views in your dashboard, such as the map, the “master.” When your users select a 

region in the map, the data in the other views is filtered so that it relates to just that 

region. 

1. On the dashboard, select the view you want to use as a filter.

2. On the view’s shortcut menu, choose Use as Filter. You can perform the same

action by clicking the Use as Filter icon

1. 

You can also use filter actions to filter the data on a dashboard when the data comes 

from multiple data sources. For more information, see Filtering Across Multiple Data 

Sources Using a Parameter in the Tableau Knowledge Base. 

For more information about filter actions, see Filter Actions. 

http://kb.tableau.com/articles/howto/filter-multiple-data-sources-using-parameter
http://kb.tableau.com/articles/howto/filter-multiple-data-sources-using-parameter
https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_filter.htm
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Use multiple views to filter other views in a 

dashboard 

Similar to how you can use a single view to filter other views in a dashboard, you can 

also use multiple views as a filter. This is sometimes called having a “multi-master” 

dashboard. The trick is to not only use the master views as filters, but to also disable 

their ability to be filtered themselves. 

1. Create or open a dashboard that has at least three views.

1. Select the first view that you want to use as a filter (such as a map), and from its

shortcut menu, select Use as Filter.
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1. Open the same view’s shortcut menu again and select Ignore Actions. This

ensures that other filter actions, including the one you’ll create next, will not

affect this view.
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1. Repeat the steps 2 and 3 for any other views you want to use as a filter.

2. Now, selecting marks in a master view filters data in one or more detail views —

all without affecting any other masters.
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Navigate from one view to another view, 

dashboard, or story (Create in Tableau Desktop) 

Use the Go to Sheet action to let users quickly navigate to a related visualization — a 

dashboard, sheet, or story — when they click on a mark or a tooltip menu item in the 

original view. 

Note: To simply navigate from one dashboard to another, without requiring users to 

interact with data, consider using the Button object. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_create.htm#Add_objects
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1. From your dashboard, select Dashboard > Actions.

2. In the Actions dialog box, click Add Action and then select Go to Sheet.

3. Specify a name for action. (If you choose to run the action using a menu, the

name you specify here is what’s displayed.)

4. Under Source Sheets, select the view that will initiate the action.
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5. Specify how people viewing your dashboard will run the

action. Select or Menu are the best choices for a navigation action.

6. If you choose Select, consider selecting the Run on single select option so

users won’t navigate away from the view when exploring multiple marks.

7. For Target Sheet, select the navigation destination that appears when users click

marks or tooltip menu items in the source sheet. Then click OK.

Interactively display a web page in a dashboard 

(Create in Tableau Desktop) 

To interactively display information from the web inside a dashboard, you can use a 

URL action with a web page object. For example, you might have a dashboard that 

shows profits by country. In addition to showing the profit data in your dashboard, 

you also want to display supplemental information about the countries from a web 

site. 

Tip: To easily organize and target multiple web page objects in a dashboard, rename 

them. 

1. Drag a Web Page object onto your dashboard, and enter a URL.

1. From your dashboard, select Dashboard > Actions.

2. In the Actions dialog box, click Add Action and then select Go to URL.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_organize_floatingandtiled.htm#Rename
https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_organize_floatingandtiled.htm#Rename
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3. Specify a name for the link. If you choose to run the action using a menu, such as

a menu option on a tooltip, the name you specify here is what’s displayed.

1. Under Source Sheets, select the view or data source that will initiate the action.

For example, if you want the action to be initiated when a user clicks a link on a

map’s tooltip, select the map view.

2. Specify whether people viewing your dashboard will run the action on hover,

select, or menu. For details, see Running Actions.

3. Enter the URL, starting with the http:// or https:// prefix, such

as http://www.example.com.

4. You can use field values as parameters in your URL. For example, if Country is a

field used by a view in your dashboard, you can use <Country> as a parameter in

your URL. For details, see URL Actions.

1. For URL Target, select Web Page Object, and select the object you created in

step 1.

2. When you launch the action, a web page automatically loads within the

dashboard rather than opening a separate browser window.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_running.htm
http://www.example.com./
http://www.example.com./
https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_url.htm
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• Modify existing dashboard layout for mobile devices

Dashboards can include layouts for different types of devices that span a wide range 

of screen sizes. When you publish these layouts to Tableau Server or Tableau Online, 

people viewing your dashboard experience a design optimized for their phone, tablet, 

or desktop. As the author, you only have to create a single dashboard and deliver a 

single URL. 
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Tip: In addition to optimizing layouts for mobile, optimize workbook performance to 

better meets the needs of mobile users, who often have limited bandwidth and are in a 

hurry. 

How the default dashboard relates to device 

layouts 

Device layouts appear on the Dashboard tab, under Default. Initially, each device 

layout contains every item in the Default dashboard and derives its size and layout 

from Default as well. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/performance_tips.htm#performance_tips.html
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Think of the Default dashboard as the parent, and the device layouts (desktop, tablet, 

and phone) as its children. Any view, filter, action, legend or parameter that you want 

to add to a device layout must first exist in the Default dashboard. 

Phone layouts and the Default dashboard 

By default, Phone layouts are automatically generated whenever you create a new 

dashboard. To create them only for specific dashboards, from the Dashboard menu, 

deselect Auto-Generate Phone Layouts. 

Phone layouts provide a unique Use automatic layout option, which automatically 

synchronizes any changes to the Default dashboard, saving you time. If you instead 

choose Edit layout myself, the Phone layout becomes fully independent, so you’ll 

need to manually add and arrange items to reflect changes to the Default dashboard. 

Desktop and Tablet layouts and the Default 

dashboard 
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Unlike Phone layouts, you need to manually add Desktop and Tablet layouts to a 

dashboard. Desktop and Tablet layouts are always fully independent from the Default 

dashboard, so each device layout can contain a unique arrangement of objects. 

Preview and add device layouts 

1. Open a dashboard.

2. On the Dashboard tab on the left, click Device Preview.
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1. In device preview mode, these options appear above the dashboard:

1. Take a moment to click through the Device types and Models and explore the

different screen sizes. Then set these options:

• To see how the dashboard will look in landscape vs. portrait mode, click

• . Usually, landscape is optimal for tablets and portrait is best for phones.

• Select Tableau Mobile app to see how the dashboard will look with the app

instead of the browser. This option is available for iOS or Android devices and

shrinks the dashboard slightly, leaving space for the app controls.

1. Choose a Device type, such as Tablet.

1. In the upper-right corner, click the Add Layout button for the device type you

selected (for example, Add Tablet Layout).
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1. Add an additional layout by selecting a new Device type and clicking Add

Layout.

1. Creating a layout for each device type gives you the most control over your users’

experience as they view your dashboard from different devices. After you publish

a dashboard with all three layouts, users won’t see the default dashboard layout;

instead, they’ll always see the appropriate device-specific layout.

Note: If you make changes to a view, double-check related devices layouts to ensure 

that they look as you expect. 
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Customize a device layout 

After you’ve added a device layout to your dashboard, you can start rearranging 

objects to create the look you want. 

1. For Desktop and Tablet layouts, click Custom. For Phone layouts, click Edit

layout myself.

1. Click the image to replay it.

2. If you remove an item from the device layout, it’s only removed from that layout.

It still exists on the default dashboard and can be added back to the device layout

again.
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1. Anything you can add to your layout is listed on the left, under Layout. If an item

has a blue check mark, it means that it’s part of the device layout you’re currently

working on.

1. Click through the Device model options to see how the layout will appear on

different models.



 pg. 253 

ITS427 Tableau Certification 

1. Ultimately, it’s the size of the web browser that loads the dashboard that

determines which layout appears on the device. For details, see Confirm which

layout a device will display.

2. At left, explore the options under Size.

1. Default: The height and width of the device layout mimics whatever the default

dashboard is using. For example, if you’re creating a tablet layout and the default

dashboard is set to a fixed size of Desktop Browser (1000 x 800), setting Size to

Default for the tablet layout will make it use 1000 x 800 as well.

2. Fit all: All items are automatically resized to fit the device frame size. The device

frame size is determined by the Device type, Model, and orientation (portrait or

landscape) settings.

3. Fit width (recommended for phones): Items are automatically resized to fit the

width of the device frame, but the height is fixed. This is a great option for phone

layouts and vertical scrolling.

Optimize for phones 

The small screens of mobile phones benefit from further optimization. Try these 

techniques. 

Optimize manual phone layouts 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_dsd_create.htm#Confirm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_dsd_create.htm#Confirm
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If you’ve chosen to edit a phone layout yourself, you can quickly optimize the 

placement of filters, remove white space, and more. On the Dashboard tab, click the 

pop-up menu to the right of Phone, and select Rearrange layout. 

Be aware that this command only rearranges items currently in the phone layout. If 

you want to continuously update the phone layout to reflect all changes to the default 

dashboard, select Use automatic layout. 

Add links that trigger instant messages and 

phone calls 

To let phone users quickly contact key people about dashboard content, add URL 

actionsto objects that automatically trigger SMS messages and telephone calls. Use 

the link format sms:phone-number or tel:phone-number. Be sure to include country 

and area codes if necessary. 

Create phone-specific versions of views 

Create duplicates of certain views in the default dashboard — one optimized for 

desktop viewing and a second optimized for phones. 

1. Go to the worksheet for a view, click its tab, and select Duplicate Sheet.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_url.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/actions_url.htm
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1. Customize the view for mobile viewing.

2. For maps for example, you may want to zoom in to a specific region by default, or

you may want to disable panning, zooming, and other functionality.

See Customize How People Interact with your Map.

1. Now add the new view to the default dashboard so that it can be available to the

device layouts you’re creating.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/maps_customize_interaction.htm
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Shorten titles 

Short titles work best for mobile viewing. To edit a title, double-click it. 

Optimize white space 

White space is another visual element to consider. While screen real estate on a phone 

is scarce and you want to make the most of it, you may also want to provide additional 

safe places for your users to tap or initiate scrolling, so they don’t select filters and 

other items unintentionally. 

To add white space, use padding or Blank objects. For more information, see Size and 

Lay Out Your Dashboard. 

Publish the dashboard 

1. Click Server > Publish Workbook. If you’re not already signed in, you’re

prompted for your credentials.

2. In the Publish Workbook to Tableau Server dialog box, make sure the Show

sheets as tabs check box is cleared.

1. When this check box is selected for device-specific dashboards, the tabs’ sizing

requirements interfere with the server’s ability to correctly detect the size of the

web browser and load the correct layout.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_organize_floatingandtiled.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/dashboards_organize_floatingandtiled.htm
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2. Click Publish.

Test the dashboard 

After you publish the dashboard to Tableau Server or Tableau Online, test the 

dashboard by viewing it from different browser sizes. 

1. Open the dashboard on Tableau Server or Tableau Online.

2. In the upper-right corner of the page, click Share and copy the contents of

the Linktext box.

1. Paste the string into a web browser URL. The string should include the

following: embed=y

2. With the embed code string as your browser URL, test the different layouts by

changing the size of your web browser window and refreshing it.

Confirm which layout a device will display 

The dashboard layout a device displays is based on the smallest dimension (height or 

width) of the iframe in which the Tableau view appears. Sometimes Desktop, Tablet, 
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or Phone layouts may appear on other types of devices. For example, a Tablet layout 

may appear on a desktop computer if the display or browser window is small. 

If the smallest iframe dimension is …This device layout appears …500 pixels or 

lessPhoneBetween 501 and 800 pixelsTabletGreater than 800 pixelsDesktop 

If Tableau Online and Tableau Server users find a Phone or Tablet layout too limiting, 

they can click See Desktop Layout in the toolbar. This toggle button lets users 

switch back to the mobile device layout at any time. 

• Create a story using dashboards or views

Create a story point 

1. Click the New Story tab.

1. Tableau opens a new story as your starting point:
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1. In the lower-left corner of the screen, choose a size for your story. Choose from

one of the predefined sizes, or set a custom size, in pixels:
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1. Note: Choose the size your story will be viewed at, not the size you’re authoring

in.

2. By default, your story gets its title from the sheet name. To edit it, right-click the

sheet tab, and choose Rename Sheet.

3. If you’re using Tableau Desktop, you can also rename a story by double-clicking

the title.

4. To start building your story, double-click a sheet on the left to add it to a story

point.

5. In Tableau Desktop, you can also drag sheets into your story point.
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1. When you add a sheet to a story point, that sheet remains connected to the

original sheet. If you modify the original sheet, your changes will automatically be

reflected on the story points that use it.

2. If you are using Tableau Server or Tableau Online to author on the web and the

original sheet has Pause Auto Updates enabled, the story sheet will be blank

until auto-updates are resumed.

3. Click Add a caption to summarize the story point.

4. In Tableau Desktop, you can highlight a key takeaway for your viewers by

dragging a text object to the story worksheet and typing a comment.

5. To further highlight the main idea of this story point, you can change a filter or

sort on a field in the view. Then save your changes by clicking Update on the

story toolbar above the navigator box:
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1. Add another story point by doing one of the following:

• Click Blank to use a fresh sheet for the next story point.

• Start customizing a story point and click Save as New on the toolbar above the

navigator box.

• Click Duplicate to use the current story point as the basis for a new one.

Explore layout options 

You can refine the look of your story using the options on the Layout tab. 

1. Click the Layout tab.

2. Choose a navigator style that best suits your story, and show or hide the next and

previous arrows.



 pg. 263 

ITS427 Tableau Certification 

Format a story 

Resize captions (Tableau Desktop only) 

Sometimes the text in one or more of your captions is too long to fit inside the height 

of the navigator. In this case, you can re-size the captions vertically and horizontally. 

1. In the navigator, select a caption.

2. Drag the border left or right to resize the caption horizontally, down to resize

vertically, or select a corner and drag diagonally to resize the caption both

horizontally and vertically.

3. All captions in the navigator update to the new size.

When you resize a caption, you can only select the left, right, or bottom border of the 

caption. 

Fit a dashboard to a story 
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You can fit a dashboard to the exact size of a story. For example, if your story is 

exactly 800 by 600 pixels, you can shrink or expand a dashboard to fit inside that 

space. 

Click the Size drop-down menu and select the story you want the dashboard to fit 

inside. 

Format a story’s shading, title, and text objects 

(Tableau Desktop only) 

To open the Format Story pane, select Format > Story. 
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Clear all formatting (Tableau Desktop only) 

• To reset a story to its default format settings, click the Clear button at the bottom

of the Format Story pane.

• To clear a single format setting, right-click (Windows) or control-click (macOS)

the format setting you want to undo in the Format Story pane. Then

select Clear.

• For example, if you want to clear the alignment of the story title, right-click

(control-click on Mac) Alignment in the Title section, and then select Clear.
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Delete a story point 

Click the X in the toolbar above the point’s caption: 

Present your story 

1. In Tableau Desktop, click the Presentation Mode button
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1. on the toolbar. Or, publish the story to Tableau Online or Tableau Server, and

click the Full Screen button in the upper-right corner of the browser.

2. To step through your story, click the arrow to the right of the story points. Or, in

Tableau Desktop, use the arrow keys on your keyboard.

3. To exit Presentation or Full Screen mode, press Esc.

• Share a twbx as a PDF

PDF by selecting File > Print to PDF. 

• Share a twbx as an image

1. Select Worksheet > Export> Image.

2. In the Copy Image dialog box, select the contents you want to include in the

image and the legend layout (if the view contains a legend).

3. Click Save.

4. In the Save Image dialog box, navigate to where you want to save the image file

and type a file name into the text box. Select a file format from the Save as type

drop-down menu.

5. Click Save.

• Share a twbx as a PDF

https://onlinehelp.tableau.com/current/pro/desktop/en-us/help.html#publish_workbooks_share.html
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You can publish one or more views to PDF by selecting File > Print to PDF.These 

static views can be embedded in PowerPoint presentations or Microsoft Word 

documents or sent in an email. 

• Share a twbx as an image

• To create a BMP on Windows or a TIFF on a Mac Worksheet > Copy > Image

• On MS Windows, save the image as Enhanced Metafile (*.emf) Worksheet >

Export > Image

Part 4: Understanding 

Tableau Concepts 

Dimension fields in the view 

When you click and drag a discrete dimension field from the Dimensions area 

to Rows or Columns, Tableau creates column or row headers. 
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In many cases, fields from the Dimension area will initially be discrete when you 

add them to a view, with a blue background. Date dimensions and numeric 

dimensions can be discrete or continuous, and all measures can be discrete or 

continuous. 

After you drag a dimension to Rows or Columns, you can change the field to a 

measure just by clicking the field and choosing Measure. Now the view will contain a 

continuous axis instead of column or row headers, and the field’s background will 

become green: 
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Date dimensions can be discrete or continuous. Dimensions containing strings or 

Boolean values cannot be continuous. 

Tableau does not aggregate dimensions. For a discussion of the different types of 

aggregation Tableau can perform, see List of Predefined Aggregations in Tableau. 

In Tableau queries, dimensions in the view are expressed in SQL as “Group By” 

clauses. 

For details on converting fields between continuous and discrete, see Convert Fields 

between Discrete and Continuous. 

How dimensions affect the level of detail in the 

view 

The level of detail in a view refers to how granular the data is given the dimension and 

measure data in the view. 

As you add dimensions to Rows or Columns, the number of marks in the view 

increases. 

To understand why adding dimensions increases the number of marks in the view, do 

the following: 

1. Drag Segment to Columns.

2. The status bar at the bottom of the Tableau window shows you that there are now

three marks in the view:

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#AggFuncs
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_typesandroles_convertdisctocont.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_typesandroles_convertdisctocont.htm
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1. Those marks just contain placeholder text, Abc, because you are only building the

view's structure at this point.

2. Drag Region to Columns.

3. Now there are 12 marks. Three values in Segment multiplied by four values

in Region is 12.

4. Drag [Ship Date] to Rows.

5. The total is now 57 marks (three segments by four regions by five years is 60, but

there are three combinations of the dimensions in the view for which there is no

data in the data source).

6. We could continue adding dimensions to Rows and Columns and observe as

the number of total marks continues to increase. Dragging a dimension to a

location on the Marks card such as Color or Size will also increase the number of

marks, though it will not increase the number of headings in the view. The

process of adding dimensions to the view to increase the number of marks is

known as setting the level of detail.

7. Adding a dimension to any of the following locations in Tableau affects the level

of detail:



 pg. 272 

ITS427 Tableau Certification 

1. The view now contains 57 separate instances of Abc—the view is all structure and

no content. Rectify this by dragging Sales to Text. The view can now be

considered complete:

Notes 
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• In some cases, adding a measure to the view can increase the number of marks in

the view. For example, if you dropped Sales on Rows in the view above, the

number of marks would be 57. But if you then also dropped Profit on Rows, the

number of marks would increase to 114. But this is not the same as changing the

view’s level of detail.

• The number of marks in the view is not guaranteed to correspond to the number

you would get by multiplying the number of dimension values in each of the

dimensions that make up the level of detail. There are multiple reasons why the

number of marks could be lower. To increase the number of marks in this view

from 57 to 60 in the view above, right-click (Control-click on a Mac) on one of the

Date headers in the view and the date or bin headers and choose Show Missing

Values. For more information about how to show missing values, see Show or

Hide Missing Values or Empty Rows and Columns.

Measure fields in the view 

When you drag a measure to the view, it is aggregated by default. The type of 

aggregation will vary depending on the type of view. You should always check the 

aggregation and change it if necessary. For details, see “Change the default 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/missing_values.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/missing_values.htm
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aggregation” in Edit Default Settings for Fields. For more details about aggregation, 

see Data Aggregation in Tableau. 

When you drag a continuous field from the Measures area to Rows or Columns, 

Tableau creates a continuous axis for that field. 

If you click the field and change it to Discrete, the values become column headers. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_fieldproperties.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm
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Tableau continues to aggregate values for the field, because even though the field is 

now discrete, it is still a measure, and Tableau aggregates measures by default. 

In cases where Tableau has misclassified a field as a dimension or a measure, possibly 

because of the data type, you can convert it and change its role. If a measure contains 

numbers that don’t need to be aggregated (such as a field that contains date values), 

you may want to convert it to be a dimension. 

For related details, see Convert a Measure to a Dimension. 

For details on converting fields between continuous and discrete, see Convert Fields 

between Discrete and Continuous. 

How continuous and discrete fields change the 

view 

Continuous and discrete are mathematical terms. Continuous means “forming an 

unbroken whole, without interruption”; discrete means “individually separate and 

distinct.” 

In Tableau, fields can be either continuous or discrete. When you drag a field from 

the Measures area to Columns or Rows, the values are continuous by default and 

Tableau creates an axis. When you drag a field from the Dimensions area of 

the Data pane to Columns or Rows, the values are discrete by default and Tableau 

creates column or row headers. 

Continuous fields produce axes 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_typesandroles_convertdimtomeas.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_typesandroles_convertdisctocont.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_typesandroles_convertdisctocont.htm
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If a field has values that are numbers that can be added, averaged, or otherwise 

aggregated, Tableau assigns that field to the Measures area of the Data pane when 

you first connect to a data source. Tableau is assuming that the values are continuous. 

Tableau displays an axis when you drag a continuous field to Rows or Columns. An 

axis is a measuring line that shows values between a minimum and a maximum. 

Rulers and analog thermometers are examples of physical objects that display axes. 

Tableau must be able to show a range of actual and potential values, because in 

addition to the initial values in the data source, it is always possible that new values 

will emerge as you work with a continuous field in the view. 

While there are value labels on a continuous axis (0, 0.5, … 3.0 in the following 

image), actual marks don’t have to align with these labels as they would with column 

headers. For example, in the following image, the blue bar actually extends to a value 

of 6.940 on the horizontal axis, not 7.0 exactly. 

The number of potential values for continuous fields is impossible to anticipate. For 

example, if you have a field named Ratings and the initial values are 1, 3, 3.5, 3.6, 

and 4, that’s five distinct values. But if you drop Ratings on Rows, Tableau 

automatically aggregates that value as SUM (which you would then immediately 
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change to AVG, because it’s more logical to average grades than to add them), and 

that would then create a sixth value (3.02) that didn’t exist until you added the field to 

the view. And if you then applied a filter that eliminated two of the initial values, the 

average would change as well, so that would be yet another value. And then if you 

changed the aggregation, … You get the idea. The number of potential values is, if not 

infinite, then certainly immense. 

The fact that a field contains numbers does not automatically indicate that those 

values are continuous. Postal codes are the classic example: though they are often 

composed entirely of numbers, they are actually string values which shouldn’t be 

added or averaged. If Tableau assigns such a field to the Measures area, you should 

drag it up to the Dimensions area. 

Discrete fields create headers 

If a field contains values that are names, dates, or geographical locations — anything 

other than numbers — Tableau assigns that field to the Dimensions area of 

the Data pane when you first connect to a data source. Tableau treats the values as 

discrete. 

Tableau creates headers when you drag a discrete field to Columns or Rows. The 

individual values for a discrete field become the row or column headings. Because 

these types of values are never aggregated, no new field values are created as you work 

with your view, so there is no need for an axis. 

Discrete versus continuous fields on filters 

• When you drop a discrete dimension field on the Filters shelf, Tableau prompts

you to choose which “members” of the discrete field to include in the view.
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• When you drop a Date field on Filters, the result can be a discrete filter or a

continuous filter. For more information, see Filter dates .

• When you drop a continuous measure on Filters, Tableau first prompts you to

choose an aggregation for the filter, and then prompts you to specify how to filter

the continuous range of values.

• When you drop a continuous dimension on Filters (other than a Date), Tableau

prompts you to specify how to filter the continuous range of values.

For more on filtering various types of fields, see Drag dimensions, measures, and date 

fields to the Filters shelf . 

Discrete versus continuous fields on color 

When you drop a discrete field on Color in the Marks card, Tableau displays a 

categorical palette and assigns a color to each value of the field. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#FilterDates
https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#Drag
https://onlinehelp.tableau.com/current/pro/desktop/en-us/filtering.htm#Drag
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When you drop a continuous field on Color, Tableau displays a quantitative legend 

with a continuous range of colors. 

For more information about color palettes, see Color Palettes and Effects. 

When you connect to a new data source, Tableau assigns each field in the data source 

to either the Dimensions area or the Measures area of the Data pane, depending 

on the type of data the field contains. You use these fields to build views of your data. 

About data field roles and types 

Data fields are made from the columns in your data source. Each field is automatically 

assigned a data type (such as integer, string, date), and a role: Discrete Dimension or 

Continuous Measure (more common), or Continuous Dimension or Discrete Measure 

(less common). 

• Dimensions contain qualitative values (such as names, dates, or geographical

data). You can use dimensions to categorize, segment, and reveal the details in

your data. Dimensions affect the level of detail in the view.

• Measures contain numeric, quantitative values that you can measure. Measures

can be aggregated. When you drag a measure into the view, Tableau applies an

aggregation to that measure (by default).

• Explain what kind of information dimensions usually contain

Possible combinations of fields in Tableau 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/viewparts_marks_markproperties_color.htm
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This table shows examples of what the different fields look like in the view. People 

sometimes call these fields “pills”, but we refer to them as “fields” in Tableau help 

documentation. 

Discrete Dimensions 

Continuous Dimensions (dimensions with a data type of String or Boolean cannot 

be continuous) 

Discrete Measures 

Continuous Measures 

Note: With a cube (multidimensional) data source, the options for changing data 

roles are limited. In Tableau Desktop, cubes are supported only on Windows.) You 

can change some measures from continuous to discrete, but in general, you cannot 

change data roles for fields in cube data sources. For related details, see Cube Data 

Sources. 

A visual cue that helps you know when a field is a measure is that the field is 

aggregated with a function, which is indicated with an abbreviation for the 

aggregation in the field name, such as: 

. To learn more about aggregation, see List of Predefined Aggregations in 

Tableau and Aggregate Functions in Tableau. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/cubes.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/cubes.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#AggFuncs
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#AggFuncs
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_calculatedfields_aggregate_create.htm
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But there are exceptions: 

• If the entire view is disaggregated, then by definition no field in the view is

aggregated. For details, see How to Disaggregate Data.

• If you are using a multidimensional data source, fields are aggregated in the data

source and measures fields in the view do not show that aggregation.

Note: You can set the default aggregation and other properties and settings for fields. 

For details on the many ways you can customize the fields in the Data pane, 

see Organize and Customize Fields in the Data Pane, Edit Default Settings for Fields, 

and Work with Data Fields in the Data Pane. 

• Explain what kind of information measures usually contain

• Discrete and continuous fields

In both examples, the Sales field is set to Continuous. It creates a vertical axis 

because it continuous and it’s been added to the Rows shelf. If it was on the Columns 

shelf, it would create a horizontal axis. The green background and aggregation 

function (in this case, SUM) help to indicate that it’s a measure. 

The absence of an aggregation function in the Quantity field name help to indicate 

that it’s a dimension. 

• Explain how discrete fields are displayed in Tableau

blue 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#DisAggData
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_dwfeatures.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_fieldproperties.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_understanddatawindow.htm
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• Explain how continous fields are displayed in Tableau

green 
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• Explain the difference between discrete date parts and continous date

values in Tableau

Continuous Dates 

Version: 2019.1 Applies to: Tableau Desktop, Tableau Online, Tableau Public, 

Tableau Server 

You can treat a date as a continuous quantity after placing the field on a shelf. You do 

this by selecting one of the Continuous date options on the field’s context menu 

(lower list of date levels). Continuous dates draw a quantitative axis for the date 

values. 
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For example, the view below displays the sales as a function of a continuous order 

date and is color-encoded by category. As you can see, the color of the Order 

Date field changes from blue to green after it is converted to a continuous quantity. 

Treating dates as a continuous quantity is particularly useful when you use Gantt bars 

or want to see trends using line charts as shown above. 

By default, date dimensions are discrete fields for which Tableau automatically selects 

a date level when it is placed on a shelf. To make a date dimension continuous by 

default, right-click (control-click on Mac) the field in the Data pane and 

select Convert to Continuous. The field turns green and is automatically converted 

to a continuous field when you drag it to a shelf. To revert to discrete again, right-click 

(control-click on Mac) the field in the Data pane and select Convert to Discrete. 
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Aggregation 

Data Aggregation in Tableau 

Version: 2019.1 Applies to: Tableau Desktop 

In Tableau, you can aggregate measures or dimensions, though it is more common to 

aggregate measures. Whenever you add a measure to your view, an aggregation is 

applied to that measure by default. The type of aggregation applied varies depending 

on the context of the view. 

Change the Aggregation of a Measure in the 

View 

When you add a measure to the view, Tableau automatically aggregates its values. 

Sum, average, and median are common aggregations; for a complete list, see List of 

Predefined Aggregations in Tableau. 

The current aggregation appears as part of the measure’s name in the view. For 

example, Sales becomes SUM(Sales). Every measure has a default aggregation 

which is set by Tableau when you connect to a data source. You can view or change 

the default aggregation for a measure — see Set the Default Aggregation for a 

Measure. 

You can aggregate measures using Tableau only for relational data sources. 

Multidimensional data sources contain data that is already aggregated. In Tableau, 

multidimensional data sources are supported only in Windows. 

You can change the aggregation for a measure in the view from its context menu: 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#AggFuncs
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#AggFuncs
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#DefaultAgg
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#DefaultAgg
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Aggregating Dimensions 

You can aggregate a dimension in the view as Minimum, Maximum, Count, 

or Count (Distinct). When you aggregate a dimension, you create a new temporary 

measure column, so the dimension actually takes on the characteristics of a measure. 
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Note: The Count (Distinct) aggregation is not supported for Microsoft Access data 

sources, and for Microsoft Excel and Text File data sources using the legacy 

connection. If you are connected to one of these types of data sources, the Count 

(Distinct) aggregation is unavailable and shows the remark “Requires extract.” If 

you save the data source as an extract, you will be able to use the Count 

(Distinct)aggregation. 

Another way to view a dimension is to treat it as an Attribute. Do this by 

choosing Attribute from the context menu for the dimension. 

The Attribute aggregation has several uses: 

• It can ensure a consistent level of detail when blending multiple data sources.

• It can provide a way to aggregate dimensions when computing table calculations,

which require an aggregate expression.

• It can improve query performance because it is computed locally.
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Tableau computes Attribute using the following formula: 

IF MIN([dimension]) = MAX([dimension]) THEN MIN([dimension]) ELSE "*" END

The formula is computed in Tableau after the data is retrieved from the initial query. 

The asterisk (*) is actually a visual indicator of a special type of Null value that occurs 

when there are multiple values. See Troubleshoot Data Blending to learn more about 

the asterisk. 

Below is an example of using Attribute in a table calculation. The table shows sales by 

market, market size, and state. Suppose you wanted to compute the percent of total 

sales each state contributed to the market. When you add a Percent of Total quick 

table calc (see Quick Table Calculations) that computes along State, the calculation 

computes within the red area shown below. This is because the Market Size 

dimension is partitioning the data. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/multipleconnections_troubleshooting.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_tablecalculations_quick.htm
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When you aggregate Market Size as an Attribute, the calculation is computed within 

the Market (East, in the following image), and the Market Size information is used 

purely as a label in the display. 

List of Predefined Aggregations in Tableau 

Sometimes it is useful to look at numerical data in an aggregated form such as a 

summation or an average. The mathematical functions that produce aggregated data 

are called aggregation functions. Aggregation functions perform a calculation on a set 

of values and return a single value. For example, a measure that contains the values 1, 

2, 3, 3, 4 aggregated as a sum returns a single value: 13. Or if you have 3,000 sales 

transactions from 50 products in your data source, you might want to view the sum of 

sales for each product, so that you can decide which products have the highest 

revenue. 

You can use Tableau to set an aggregation only for measures in relational data 

sources. Multidimensional data sources contain aggregated data only. 
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Note: Using floating-point values in combination with aggregations can sometimes 

lead to unexpected results. For details, see Understanding data types in calculations. 

Tableau provides a set of predefined aggregations that are shown in the table below. 

You can set the default aggregation for any measure that is not a calculated field that 

itself contains an aggregation, such as AVG([Discount]). See Set the Default 

Aggregation for a Measure. You can also set the aggregation for a field already in the 

view. For details, see Change the Aggregation of a Measure in the View. 

AGGREGATIONDESCRIPTIONRESULT FOR MEASURE THAT CONTAINS 1, 2, 2, 

3Attribute 

Returns the value of the given expression if it only has a single value for all rows in the 

group, otherwise it displays an asterisk (*) character. Null values are ignored. This 

aggregation is particularly useful when aggregating a dimension. To set a measure in 

the view to this aggregation, right-click (control-click on Mac) the measure and 

choose Attribute. The field then changes to show the text ATTR: 

N/ADimensionReturns all unique values in a measure or dimension.3 values (1, 2, 

3)SumReturns the sum of the numbers in a measure. Null values are ignored.1 value

(8)AverageReturns the arithmetic mean of the numbers When applied to a

dimension, Tableau creates a new temporary column that is a measure because the 

result of a count is a number. You can count numbers, dates, booleans, and strings. 

Null values are ignored in all cases.1 value (4)Count (Distinct) 

Returns the number of unique values in a measure or dimension. When applied to a 

dimension, Tableau creates a new temporary column that is a measure because the 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/functions_operators.htm#Data
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#DefaultAgg
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#DefaultAgg
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#Measures
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result of a count is a number. You can count numbers, dates, booleans, and strings. 

Null values are ignored in all cases. 

This aggregation is not available for the following types of workbooks: 

• Workbooks created before Tableau Desktop 8.2 and that use Microsoft Excel or

Text File data sources.

• Workbooks that use legacy connections.

• Workbooks that use Microsoft Access data sources.

If you are connected to a workbook that uses of one of these types, Count (Distinct) is 

unavailable and Tableau shows the message “Requires extract.” To use this 

aggregation, extract your data. See Extract Your Data. 

1 value (3)MinimumReturns the smallest number in a measure or continuous 

dimension. Null values are ignored.1 value (1)MaximumReturns the largest number in 

a measure or in the given expression based on a sample population. Null values are 

ignored. Returns a Null if there are fewer than 2 members in the sample that are not 

Null. Use this function if your data represents a sample of the population.1 value 

(0.8165)Std. Dev (Pop.)Returns the standard deviation of all values in the given 

expression based on a biased population. Assumes that its arguments consist of the 

entire population. Use this function for large sample sizes.1 value 

(0.7071)VarianceReturns the variance of all values in the given expression based on a 

sample. Null values are ignored. Returns a Null if there are fewer than 2 members in 

the sample that are not Null. Use this function if your data represents a sample of the 

population.1 value (0.6667)Variance (Pop.)Returns the variance of all values in the 

given expression based on a biased population. Assumes that its arguments consist of 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/extracting_data.htm
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the entire population. Use this function for large sample sizes.1 value 

(0.5000)Disaggregate 

Returns all records in the underlying data source. To disaggregate all measures in the 

view, select Aggregate Measures from the Analysis menu (to clear the check mark). 

Tableau allows you to view data in disaggregated form (relational databases only). 

When data are disaggregated, you can view all of the individual rows of your data 

source. For example, after discovering that the sum of sales for rubber bands is 

$14,600, you might want to see the distribution of individual sales transactions. To 

answer this question, you need to create a view that shows individual rows of data. 

That is, you need to disaggregate the data (see How to Disaggregate Data). Another 

way to look at disaggregated data is to view the underlying data for all or part of a 

view. For more details, see View Underlying Data. 

4 values (1, 2, 2, 3) 

You can also define custom aggregations as described in Aggregate Functions in 

Tableau. Depending on the type of data view you create, Tableau will apply these 

aggregations at the appropriate level of detail. For example, Tableau will apply the 

aggregation to individual dimension members (the average delivery time in the East 

region), all members in a given dimension (the average delivery time in the East, 

West, and Central regions), or groups of dimensions (the sum of sales for all regions 

and for all markets). 

Set the Default Aggregation for a Measure 

You can set the default aggregation for any measure that is not a calculated field that 

itself contains an aggregation, such as AVG([Discount]). A default aggregation is a 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#DisAggData
https://onlinehelp.tableau.com/current/pro/desktop/en-us/inspectdata_viewdata.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_calculatedfields_aggregate_create.htm
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_calculatedfields_aggregate_create.htm
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preferred calculation for summarizing a continuous or discrete field. The default 

aggregation is automatically used when you drag a measure to a view. 

To change the default aggregation: 

Right-click (control-click on Mac) a measure in the Data pane and select Default 

Properties > Aggregation, and then select one of the aggregation options. 
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Note: You can use Tableau to aggregate measures only with relational data sources. 

Multidimensional data sources contain aggregated data only. 
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You cannot set default aggregations for published data sources. The default 

aggregation is set when the data source is initially published. Create a Local Copy of 

the published data source to adjust the default aggregation. 

How to Disaggregate Data 

Whenever you add a measure to your view, an aggregation is applied to that measure 

by default. This default is controlled by the Aggregate Measures setting in 

the Analysismenu. 

If you decide you want to see all of the marks in the view at the most detailed level of 

granularity, you can disaggregate the view. Disaggregating your data means that 

Tableau will display a separate mark for every data value in every row of your data 

source. 

To disaggregate all measures in the view: 

• Clear the Analysis >Aggregate Measures option. If it is already selected,

click Aggregate Measures once to deselect it.

When Aggregate Measures is selected, Tableau will attempt to aggregate measures 

in the view by default. This means that it collects individual row values from your data 

source into a single value (which becomes a single mark) adjusted to the level of detail 

in your view. 

http://kb.tableau.com/articles/howto/edit-a-published-data-source
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The different aggregations available for a measure determine how the individual 

values are collected: they can be added (SUM), averaged (AVG), or set to the 

maximum (MAX) or minimum (MIN) value from the individual row values. 

For a complete list of the available aggregations, List of Predefined Aggregations in 

Tableau. 

The level of detail is determined by the dimensions in your view — for information 

about the concept of level of detail, see How dimensions affect the level of detail in the 

view. 

Disaggregating your data can be useful for analyzing measures that you may want to 

use both independently and dependently in the view. For example, you may be 

analyzing the results from a product satisfaction survey with the Age of participants 

along one axis. You can aggregate the Age field to determine the average age of 

participants or disaggregate the data to determine at what age participants were most 

satisfied with the product. 

Disaggregating data can be useful when you are viewing data as a scatter plot. 

See Example: Scatter Plots, Aggregation, and Granularity. 

Note: If your data source is very large, disaggregating the data can result in a 

significant performance degradation. 

Example: Scatter Plots, Aggregation, and 

Granularity 

If you place one measure on the Rows shelf and another measure on 

the Columns shelf, you are asking Tableau to compare two numerical values. 

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#AggFuncs
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#AggFuncs
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_typesandroles.htm#DimLOD
https://onlinehelp.tableau.com/current/pro/desktop/en-us/datafields_typesandroles.htm#DimLOD
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#ExampleScatter
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Typically, Tableau chooses a scatter plot as the default visualization in such cases. The 

initial view will most likely be single mark, showing the sum for all values for the two 

measures. This is because you need to increase the level of detail in the view. 

Start building the scatter plot 

Use dimensions to add detail 

Try adding more fields to the rows and columns shelves 

Try disaggregating the data 

Start building the scatter plot 

There are various ways to add detail to a basic scatter plot: you can use 

dimensions to add detail, you can add additional measures and/or dimensions to 

the Rows and Columns shelves to create multiple one-mark scatter plots in the view, 

or you can disaggregate the data. And, you can also use any combination of these 

options. This topic looks at these alternatives using the Sample-Superstore data 

source. 

To create the initial view, follow these steps: 

1. Place the Sales measure on the Columns shelf.

2. Place the Profit measure on the Rows shelf.

https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#InitialView
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#DimOnDetail
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#RowColOpt2
https://onlinehelp.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm#TryDisAgg
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The measures are automatically aggregated as sums. The default aggregation (SUM) 

is indicated in the field names. The values shown in the tooltip show the sum of sales 

and profit values across every row in the data source. 

Follow the steps below to use dimensions to add detail to the view and to disaggregate 

data. 

Use dimensions to add detail 

Follow these steps to develop the scatter plot view you created above by adding 

dimensions to show additional levels of detail. 

1. Drag the Category dimension to Color on the Marks card.

2. This separates the data into three marks — one for each dimension member —

and encodes the marks using color.

3. Drag the State dimension to Detail on the Marks card.

4. Now there are many more marks in the view. The number of marks is equal to the

number of distinct states in the data source multiplied by the number of

categories.

Although more marks are now displayed, the measures are still aggregated. So 

regardless of whether there is one row in the data source where State = North Dakota 

and Category= Furniture, or 100 such rows, the result is always a single mark. 

Maybe this process is developing the view in a direction you find useful, or maybe you 

prefer to go in a different direction — for example, by adding a time dimension to the 

view, or by introducing trend lines or forecasting. You decide what questions to ask. 
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Try adding more fields to the rows and columns 

shelves 

Revert to the original one-mark view and follow these steps to develop the scatter plot 

view by adding fields to the Rows and Columns shelves. 

1. Drag the State dimension to the Columns shelf.

2. Even if you drop Continent to the right of SUM(Sales), Tableau moves it to the

left of SUM(Sales). This is because you cannot insert a dimension within a

continuous axis. Instead, your view shows a separate axis for each member of the

dimension.

1. Drag the Segment dimension to the Rows shelf.

2. You now have a view that provides an overview of Sales and Profit across states

and customer segments. It can be interesting to hover over the marks in the view

to see tooltip data for various segments:
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Try disaggregating the data 

Another way to modify your original one-mark scatter plot to display more marks is 

by disaggregating the data. 

Clear the Analysis >Aggregate Measures option. If it is already selected, 

click Aggregate Measures once to deselect it. 
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What you have actual done is to dis-aggregate the data, because this command is a 

toggle that was originally selected (check mark present). Tableau aggregates data in 

your view by default. 

Now you see a lot of marks — one for each row in your original data source: 

When you disaggregate measures, you no longer are looking at the average or sum for 

the values in the rows in the data source. Instead, the view shows a mark for every 

row in the data source. Disaggregating data is a way to look at the entire surface area 

of the data. It’s a quick way to understand the shape of your data and to identify 

outliers. In this case, the disaggregated data shows that for many rows in the data, 

there is a consistent relationship between sales income and profit — this is indicated 

by the line of marks aligned at a forty-five degree angle. 
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• Explain why Tableau aggregates measures

• Describe how an aggregated measure changes when dimensions are

added to the view




